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Благодарим за приобретение режущего плоттера серии GCC RX II. 

Перед началом работы с плоттером необходимо ознакомиться с мерами 

предосторожности и указаниями ниже. 
 

 
   ВНИМАНИЕ  

МЕРЫ ПРЕДОСТОРОЖНОСТИ! 

   В целях безопасности при перемещении необходимо надежно удерживать 

режущий плоттер за основание. Запрещается перемещать плоттер, удерживая 

его за боковые поверхности. 

 

  

O (Верно) X (Неверно) 
 

 Запрещается трясти и бросать держатель ножа — риск отламывания кромки ножа. 

 Запрещается касаться движущихся частей плоттера в процессе работы, 

включая каретку. Следить, чтобы в плоттер не попали волосы и одежда. 

 Кабель электропитания подключать только к розетке с заземлением. 

 Использовать только комплектный кабель электропитания. Следить, чтобы 

кабель электропитания не перекручивался и не застревал между предметами. 

 Запрещается подключать кабель электропитания к сетевому разветвителю, 

если к нему подключено другое оборудование, и использовать удлинительный 

кабель. Это может привести к перегреву и выходу устройства из строя. 

 Инструменты необходимо держать в недоступном для детей месте. 

 Прижимные ролики необходимо выравнивать по белым отметкам. 
 

 

! 
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Запрещается одновременно нажимать верхний и нижний захваты, как на 

рисунке ниже: 

 
 

O (Верно) ╳ (Неверно) 
 
Нажать:        Нажать: 

 

  
 
 

 
 
 
 

 

 

Нажать снизу, чтобы освободить захват 
 

 

 
 
 
 
 
 
 

 
 

ВКЛЮЧИТЬ 

ОТКЛЮЧИТЬ 

 Осторожно 

 

Примечание. 

Если из-за ошибок 

в эксплуатации захваты 

застряли в сведенном 

положении, необходимо 

пинцетом вытянуть 

штангу-упор, 

одновременно нажимая 

верхний захват. 

Полностью вытянув 

и зафиксировав упор, 

отпустить захваты, как на 

рисунке справа. 
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1.1 Общая информация 

Режущие плоттеры серии RX II предназначены для получения созданных на 

компьютере изображений и контурной резки рулонного и листового материала 

на основе поливинила. 

 
В настоящем руководстве по эксплуатации рассмотрены следующие модели режущих 

плоттеров серии RX II: 
 

‧RX II-61 для материалов шириной: от 50 до 810 мм 

‧RX II-101S для материалов шириной: от 50 до 1326 мм 

‧RX II-132S для материалов шириной: от 50 до 1635 мм 

‧RX II-183S для материалов шириной: от 50 до 2145 мм 

 

1.2 Упаковка 

В комплект поставки моделей серии RX II входят перечисленные ниже 

компоненты. Следует внимательно проверить комплектацию и в случае нехватки 

компонентов обратиться к региональному дилеру. 
 

ССттааннддааррттннааяя  ккооммппллееккттаацциияя   ККоолл--ввоо  

1. Режущий плоттер 1 
2. Типовая комплектация (только для RX II-101S/132S/183S)  
    (Расширенная для RX II-61) 
 Стойка T-образная — 2 шт. 
 Траверса стойки — 1 шт. 
 Винты M6 — 18 шт. 
 Ключ под шестигранник Г-образный для винтов М5 — 1 шт. 
 Руководство по сборке стойки — 1 шт. 

 

 
1 

Раздел 1. Общие сведения 
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3. Модульная опора для гибких материалов 
 
 

 
 
 
 
 
 
 
 
 

 
1 

4. Дополнительные компоненты 
 Компакт-диск пользователя — 1 шт. 
 Шнур питания — 1 шт. 
 Кабель передачи данных — 1 шт. (кабель USB длиной 3 м) 
 Узел держателя ножа — 1 шт. (устанавливается в каретку режущего 

плоттера) 
 Нож — 1 шт. (устанавливается в держатель) 
 Безопасный нож — 1 шт. 
 Марзан для резки поливинила — 1 шт. 
 Плоскогубцы -— 1 пара 
 Карта Promise — 1 шт. 

 
 
 
 

 
1 

 

1.3 Технические характеристики 
 

Ниже перечислены основные технические характеристики режущих плоттеров RX II: 

 
• Подключение к трем портам: последовательный, USB, Ethernet. 

• Усилие реза до 600 г. 

• Скорость реза до 1530 мм/с (под углом 45°). 

• Работа с материалами толщиной до 0,8 мм. 

• Гарантированное отслеживание длины в 10 м. 

• Удобная панель управления с возможностью переключения языка. 

• Улучшенная система автоматического выравнивания (AAS II) для автоматической 
контурной резки. 

• Оригинальная корзина для материала (дополнительно). 

Элементы 183S/132S/101S 61 

1 комплект фланцев для рулонных материалов — 2 шт. V V 

1 комплект держателей рулонов — 2 шт. V V 

1 комплект направляющих втулок — 4 шт. V V 

1 комплект опор для рулонов — 2 шт. V V 

Ключ под внутренний шестигранник Г-образный для 
винтов М6 — 1 шт. 

V V 

Руководство по монтажу стойки — 1 шт.  V 

Ключ под внутренний шестигранник Г-образный для 
винтов М5 — 1 шт. 

 V 

1 комплект настольных опорных кронштейнов — 2 шт.  V 

4 пластиковые ножки  V 

Винты M4 — 4 штуки  V 

Винты M6 — 12 штук  V 

Ключ под внутренний шестигранник Г-образный для 
винтов M4 — 1 шт. 

 V 
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1.4 Внешний вид плоттеров серии RX II 

 
1.4.1 Вид спереди (рис. 1-1) 
 

  
 

 
 

Рис. 1-1 

 
 

Решетчатые барабаны: 

перемещают материал 

вперед и назад 

в процессе работы. 
Каретка: режет материал при 

установленном ноже, рисует 

пером с модулем AAS. 

Панель управления: 

14 клавиш управления, 

1 светодиодный индикатор 

и ЖК-экран 

Отрезной паз: для 

срезания лишнего 

материала. 

Марзан: защищает нож 

при резке. 
Опорная пластина: 

удерживает 

материал при 

резке. 

Линейки: для 

выравнивания 

материала по 

прозрачным меткам 
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1.4.2 Вид сзади (рис. 1-2) 
 

 
 

 

 

 
 

Рычаг: поднимает 

и опускает прижимные 

ролики. 

Прижимные ролики: 

удерживают материал 

при резке. 
Рис. 1-2 
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1.4.3 Общий вид устройства RX II (рис. 1-3) 
 

 
 
 

 

 
Рис. 1-3 

 
 

Держатель: 
удерживает и подает 
рулон для резки. 

Втулки  

направляющей 

держателя: 
удерживают рулон 

в нужном положении 

при протягивании 

материала. 

 

Опора       держателя: 
подпирает держатели 

рулона. 

T-образная  стойка: 
служит опорой для 
режущего плоттера 

T-образная  стойка: 
служит опорой для 
режущего плоттера 

 
Траверса  стойки: 
придает устойчивость. 
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Порт последовательного интерфейса 

(RS232C) — для подключения режущего 

плоттера к компьютеру через кабель 

последовательного интерфейса 

Порт USB — для подключения режущего 

плоттера к компьютеру через кабель USB 
Рис. 1-5 

 
 

1.4 4 Левый торец (рис 1-4) 
 

 
 
 
 

1.4.5 Правый торец (рис. 1-5) 
 
 

 

 

Порт Ethernet — для подключения 

режущего плоттера по локальной сети 

Силовой выключатель — вкл. [I]; выкл. [O] 

Предохранитель — 3 А 

Соединитель питания — для шнура питания Рис. 1-4 
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1.4.6 Прижимной ролик (рис. 1-6) 
 

В зависимости от типа обрабатываемого материала для прижимных роликов 

выбирается одна из трех настроек давления. Например, при резке тонких материалов 

типа витринной тонировочной пленки давление центрального прижимного ролика 

должно быть низким. 

 
 
 
 
 
 
 

Рис. 1-6 
 

Низкое Среднее Высокое 
 

Важно: давление прижимных роликов слева и справа всегда должно быть таким же 

или выше, чем у центрального ролика. Настройки давления для прижимных роликов 

слева и справа должны быть одинаковыми. Возможные комбинации для прижимных 

роликов. (Таблица 1-1) 

 
 
 
 
 
 
 
 
 
 

Справа 
 

 

Таблица 1-1 

Слева Центр Справа 

 Высокое Среднее Высокое 

Среднее Среднее Среднее 

Среднее Низкое Среднее 

 
Центр 

Слева 
сторона 
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2.1 Меры предосторожности 
 

Перед началом установки изучить информацию ниже. 
 

 Примечание 1 
 

 Перед установкой режущего плоттера убедиться, что силовой выключатель 
находится в выключенном положении. 

 

 Во избежание травм соблюдать осторожность при перемещении плоттера. 
 
 
 

 Примечание 2 Порядок выбора места установки режущего плоттера 
 

До начала установки режущего плоттера выбрать подходящее место, отвечающее 
следующим условиям. 

 

 Имеются удобные подходы к устройству со всех сторон. 
 

 Имеется достаточно места для плоттера, вспомогательного оборудования 
и расходных материалов. 

 

 Поверхность установки устойчива, не допускает значительной вибрации. 

 Температура в помещении от 15 до 30 °C. 

 Относительная влажность воздуха в рабочей зоне от 25 до 75 %. 
 

 Устройство защищено от пыли и сквозняков. 
 

 На устройство не попадает яркий и прямой солнечный свет. 
 
 
 

 Примечание 3 Порядок подключения шнура электропитания 
 

Убедиться, что вилка шнура электропитания подходит к настенной розетке. 
Если нет, связаться с дилером. 

 

 Вставить вилку в розетку электропитания с заземлением. 
 

 Второй конец шнура электропитания подключить к разъему питания 
режущего плоттера. 

 

Раздел 2. Установка 
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 Примечание 4 Порядок затяжки и ослабления винтов 
 

При работе ключом и электрической отверткой соблюдать осторожность и не 
прилагать чрезмерных усилий при затягивании и ослаблении винтов. Для винтов 
из обычной и нержавеющей стали пользоваться следующей таблицей расчета 
усилия затяжки винта. Расчеты для винтов из других материалов не приведены. 

 

Диаметр 

винта 

Усилие затяжки (кгс/см) 

Стандарт затяжки для высокопрочных материалов 

M3 6 

M4 16 

M5 30 

M6 50 

 
 

2.2 Стойка и опора для гибких материалов (для RX II-
101S/132S/183S) 

Шаг 1 

Найти в картонной коробке с вспомогательными компонентами к стойке такие детали: 

 Нижние опоры — 2 шт. 

 Боковые опоры — 2 шт. 

 Траверса стойки — 1 шт. 

 Винты M6 — 20 шт. 

 Ключ под внутренний шестигранник Г-образный для винтов М5— 1 шт. 

 Руководство по сборке стойки — 1 шт. 
 
 

Шаг 2 

 Достать из картонной транспортной упаковки корпус и компоненты. 

 Двумя винтами прикрепить нижнюю опору к боковой опоре, получив T-

образную стойку (рис. 2-1). 

 
 
 
 
 
 
 
 
 
 
 

Рис. 2-1 
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Обращать внимание на расположение нижней опоры (колесо на передней части 

опоры оснащено тормозом, в отличие от заднего). 

 

  
 

 Шаг 3 

Траверсу поместить на T-образную стойку и собрать по меткам  (см. рис. 2-4 

и 2-5). Центровочные штифты не предусмотрены. Совмещать винты с головкой 

с внутренним шестигранником с резьбовыми отверстиями на обеих T-образных 

стойках. 

 
 

 

Рис. 2-5 
 

 

Шаг 4 

Расположив траверсу перпендикулярно к части , вставить в отверстия винты 

и затянуть их, как на рис. 2-5. Готовая стойка должна выглядеть, как на рис. 2-4. 

Стойка 

Траверса  

Рис. 2-4 

Сзади 

колес
о 

Перед
нее 

колесо 
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Шаг 5 

Извлечь режущий плоттер из коробки. Установить стойку под плоттером. 

На нижней части плоттера с каждой стороны имеется по одному отверстию для 

центровочных штифтов. Вставить штифты в отверстия. После этого вставить 

винты в отверстия на стойке, чтобы закрепить плоттер, и затянуть их, как показано 

на рис. 2-6. 

 

 

Рис. 2-6 

Винты 



Установка 2-5 

Серия RX II. Руководство 
 

 

 

Шаг 6 

Совместить отверстия на опорах держателя рулона с резьбовыми отверстиями 

стойки, наживить и затянуть винты, как показано на рис. 2-7. Резьбовые отверстия 

выбираются в зависимости от желаемого положения опоры. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-7 
3 винта 

 

 

Шаг 7 

 

Опора держателя рулона 

Поместить два держателя рулона на опору и убедиться, что белая выступающая 

часть лежит в прорези. (Рис. 2-8) 
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Шаг 8 

Сняв упаковку с держателя рулона, повернуть винт против часовой стрелки около 

трех раз (рис. 2-9). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-9 
 
 
 

Шаг 9 

Вставить торец держателя рулона без демпфера в левую опору держателя. Затем 

вставить торец держателя с демпфером в правую опору и убедиться, что белая 

выступающая часть лежит в прорези (рис. 2-10). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-10 



Установка 2-7 

Серия RX II. Руководство 
 

 

 

Шаг 10 

Затянуть винт на демпфере так, чтобы плотно притянуть держатель к правой 

опоре (рис. 2-11). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-11 
 
 
 

Шаг 11 

После сборки устройство должно выглядеть, как показано ниже (рис. 2-12). 
 

 

 
Рис. 2-12 
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2.3 Хомут и кронштейн для кабеля USB 

 
Хомут и кронштейн для кабеля USB устанавливаются только в комплекте с подставкой 

для гибких материалов. 

 

Шаг 1 Хомут для кабеля продеть сверху вниз через верхнее отверстие кронштейна. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Этой стороной вверх 
 

 

Шаг 2 Поместить кабель USB в хомут и затянуть зажим. 
 

  
 

Шаг 3 Вставить конец хомута с кабелем в нижнее отверстие кронштейна. 
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Как освободить кабель: вытянуть хомутподнять защелку ослабить зажим. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Вытянуть хомут 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Поднять защелку 
 

 Ослабить хомут 
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2.4 Настольная подставка для гибких материалов  
(только для RX II-61) 

 

Шаг 1 

Найти в коробке с вспомогательными компонентами к стойке такие детали: 

 1 комплект фланцев для рулонных материалов (2 шт.) 

 1 комплект держателей рулонов (2 шт.) 

 1 комплект направляющих втулок (4 шт.) 

 1 комплект опор для рулонов (2 шт.) 

 1 комплект настольных опорных кронштейнов (2 шт.) 

 4 пластиковые ножки 

 Винты M4 (4 шт.) 

 Винты M6 (12 шт.) 

 Ключ под внутренний шестигранник Г-образный для винтов M4 (1 шт.) 

 Ключ под внутренний шестигранник Г-образный для винтов М5 (1 шт.) 

 Ключ под внутренний шестигранник Г-образный для винтов M6  (1 шт.) 

для регулировки винтов держателей рулонов 

 Руководство по монтажу стойки (1 шт.) 
 
 

 

Шаг 2 

4 пластмассовые ножки поместить под опору для рулонов. Вставить винт M4 в 

отверстие в ножке и затянуть ключом под внутренний шестигранник для винтов M4 

(рис. 2-13). 
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Шаг 3 

Совместить опорный кронштейн с опорой держателя рулона, вставить винты 

М6 в резьбовые отверстия опоры и затянуть ключом под внутренний 

шестигранник для винтов M6 (см. рис. 2-14). 

 

Шаг 4 

Повернуть устройство нижней панелью набок и совместить опору держателей 

рулона в сборе с нижней панелью устройства. Пропустить винты M6 сквозь 

отверстия в опоре держателей, вставить в резьбовые отверстия в нижней панели 

устройства и затянуть ключом под внутренний шестигранник, как на рис. 2-15. 

 
 

 
 
 

Шаг 5 

Рис. 2-15 Держатели 

рулона 

Рис. 2-16 

Установить два держателя рулонов шипами вала в пазы в опоре держателей (рис. 2-16). 
 
 

Шаг 6 

Настольная подставка для материалов в сборе с плоттером показана на рис. 2-17. 
 

 Рис. 2-17 

Винты M6 

Отверстия 
под винты 

Держатель в сборе 
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2.5 Использование демпферного валика 

 
Регулировка демпфирования осуществляется вращением диска, как описано 

ниже. Чем больше число, тем сильнее демпфирующее усилие. Уровень 

демпфирования показан на наклейке с условным обозначением уровня 

(рис 2-18,19). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-18 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-19 
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2.6 Установка ножа 

На рис. 2-20 показан держатель ножа. Нож вставляется в нижнюю часть 

держателя. Для извлечения необходимо нажать на штифт. Запрещается касаться 

острия ножа пальцами. 

 

Головка винта 

регулировки высоты 

  Штифт 

 
 
 
 

 

Внешнее кольцо 
 

Рис. 2-20 
 

 

Шаг 1 

Вставить нож (рис 2-21). 
 

 
 

Шаг 2 

Рис. 2-21 

Протолкнуть нож в нижнюю часть держателя (рис. 2-22). 
 
 

Шаг 3 

Отрегулировать высоту режущей части, поворачивая винт регулировки ножа по 

часовой или против часовой стрелки (рис. 2-23). 
 

 

Рис. 2-23 

Рис. 2-22 

Совет: 

Оптимальной высотой режущей части 

считается лезвие, высота которого на 

0,1 мм больше толщины пленки. Если 

толщина пленки составляет 0,5 мм, 

высоту ножа необходимо установить на 

0,6 мм, чтобы нож полностью прорезал 

пленку, но не подложку. 
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Осторожн
о! 

 

Шаг 4 

Вставить держатель ножа в каретку. Убедившись, что внешнее кольцо держателя 

надежно входит в желоб каретки (см. рис. 2-24), закрепить крышку 

(рис. 2-25). 
 

 
 

 
Рис. 2-24 Рис. 2-25 

 
 

Шаг 5 Для демонтажа держателя выполнить шаги в обратном порядке. 
 

Шаг 6 Извлечение ножа. Чтобы извлечь нож, подлежащий замене, нажать на 

штифт для извлечения ножа. 

 
 
 
 
 

 

 

      
Внимание! 

Спустя определенное время эксплуатации нож утрачивает остроту; это 

может повлиять на качество реза. Компенсировать этот эффект можно 

увеличением усилия реза. Но если нож изношен и режет нестабильно, его 

следует заменить новым. Нож — это расходный материал. Для 

обеспечения качества реза его необходимо заменять так часто, как 

потребуется. Качество ножа существенно влияет на качество реза. Для 

достижения хороших результатов следует использовать ножи высокого 

качества. 
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2.7 Автоматическое определение длины ножа 

 
На рис. 2-26 показан новый держатель ножа со шкалой и каретка с меткой. Высота 

ножа в держателе определяется автоматически. На шкале будет показано, 

насколько нужно повернуть регулировочную головку. 

 
 

 
 
 

Рис. 2-26 Рис. 2-27 
 
 

На шкалу нанесено 10 делений. Каждое соответствует 0,05 мм. Соответственно,  

высота ножа регулируется в пределах от 0,00 до 5,00 мм (рис. 2-27). 

 
Чтобы отрегулировать высоту выступающей части ножа: 

 

1. До начала регулировки режущая часть должна оставаться внутри держателя. 

2. Одну из меток на держателе ножа выровнять по метке на каретке. 

3. В разделе CUT TEST (Тестирование реза) выбрать Blade Length Adjust 

(Регулировка выступающей части). Ввести нужную высоту ножа в поле Set 

Length, проверить держатель ножа, затем нажать ENTER, чтобы проверить 

высоту выступающей части. 
 

 

Примечание.  При проверке держателя ножа и высоты выступающей части 

держатель должен оставаться в одном положении. 

Шкала 

1 единица 

Деление 
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4. По завершении проверки на экране будет показано, на сколько (величина 

после обозначения CW или CCW) и в каком направлении [CW (по часовой 

стрелке) или CCW (против часовой стрелки)] повернуть регулировочную 

головку. 

Например, Turn CW 5 означает «повернуть головку на 5 делений по часовой 

стрелке» (рис. 2-28, 2-29). 

 
5. Когда значение на экране будет равно 0, система выведет сообщение 

Adjustment complete (Регулировка завершена). Высота ножа оптимальна и не 

требует корректировки. Нажать Enter, чтобы завершить настройку и приступить 

к резке. 
 

  
 

Рис. 2-28 Рис. 2-29 
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2.8 Кабельные соединения 

 
Режущий плоттер обменивается данными с компьютером через порт USB 

(Universal Serial Bus), последовательный порт (RS-232C) или Ethernet. В этом 

разделе рассмотрено подключение плоттера к основному компьютеру, а также 

настройка компьютера и обмена данными с плоттером. 

  

!! Примечание. При установке соединения через USB последовательный порт 
отключается автоматически. 

  
 

 

 
2.8.1 Интерфейс USB 

USB-интерфейс режущих плоттеров серии RX II соответствует спецификации 

универсальной последовательной шины версии 2.0 (полная скорость). 

 
2.8.1.1 Подключение режущего плоттера GCC 

1. Включить компьютер. 

2. Подключить к устройству кабель USB. Драйвер USB будет установлен 

автоматически. Обнаружение устройства занимает до нескольких минут.  

НЕ ДОПУСКАЕТСЯ отсоединять кабель USB до завершения процесса 

установки. 

3. Дважды щелкнуть на значке USB на панели задач, убедившись, что 

компьютер распознал устройство. 

Порт Ethernet 

  Последов. порт 
Порт USB 

Рис. 2-30 
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Осторожн
о! 

 

2.8.1.2 Установка драйвера 

Для быстрой установки драйвера рекомендуется использовать мгновенную 

установку. Для настройки выполнить перечисленные ниже шаги. 
 

 

Шаг 1  Вставить установочный диск DVD в устройство чтения компакт-дисков. 

Перед началом установки убедиться, что USB-устройство 

подключено. 

Шаг 2 Выбрать из списка драйверов нужную модель и нажать Windows Driver 

(Win 7 and Above) (Automatic Detection) или Windows Driver (Win 7 and 

Above) (Manual Selection), чтобы установить драйвер и модуль AAS. 
 

 
 
 

Шаг 3 Запустить установку драйвера, нажав Next. 
 

 
 

Шаг 4 Для установки драйвера пользователям Windows 7 и выше нажать 

на красную ссылку и прочесть, как отключить функцию обновлений 

Windows Update. Нажав OK, перейти к следующему шагу. 
 

 

 Если на компьютере установлена ОС Windows 7 и выше, 

в систему входить через учетную запись с правами 

администратора. 
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Шаг 5 Убедившись, что питание включено и плоттер подсоединен к разъему 

USB, нажать кнопку OK. 

  
 
 

Шаг 6 Перед началом установки подтвердить закрытие работающих программ 

и нажать OK. 

 
 
 
 

Шаг 7 Установка занимает несколько минут. По окончании установки на 

экране появится следующее сообщение, под которым нужно нажать 

ОК. Надеемся, вам понравится работать с плоттером GCC! 
 

 
 

 
Шаг 8 Чтобы установить AASII VBA в ПО CorelDRAW и Adobe Illustrator, 

закрыть CorelDRAW и Adobe Illustrator и нажать кнопку Install. 
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Шаг 9 Проверить версии CorelDRAW и AI в окне Install Message, затем нажать 

кнопку OK. 
 

 
 

 Примечание. 

 
(1) При повторной установке пользователю необходимо подтвердить,  

нужна ли ему копия уже установленного драйвера. 
 

 

(2) При выборе опции Yes будет установлена еще одна копия драйвера. 
 

 

(3) Пользователям, обновившим Adobe Illustrator или CorelDRAW, нужно 

открыть вкладку AAS Installer в окне Свойства принтера и нажать Install 

(Установить), чтобы получить доступ к последней версии модуля GCC 

AAS. 
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2.8.1.3 Удаление драйвера 
 

Перед установкой новой версии драйвера с компьютера необходимо полностью 

удалить предыдущую версию. Процедура удаления описана ниже. 

 

Шаг 1 Выполнив Control Panel > Hardware (Панель управления > Оборудование 

и звук), открыть окно Sound\Devices and Printers (Просмотр устройств 

и принтеров). Щелкнув правой кнопкой мыши на принтере, выбрать 

Remove device (Удалить устройство). 
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Шаг 2 После удаления устройства щелкнуть на любом принтере в окне и выбрать 

Print server properties (Свойства сервера печати) — для Windows 7 

и выше). Для Windows XP: щелкнуть правой кнопкой не на принтере,  

а на пустом месте в окне, и выбрать Print server properties. 
 

 
 

 

Шаг 3 Перейти на вкладку Drivers (Драйверы). 
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Шаг 4 Выбрав нужную модель, нажать Remove (Удалить). 
 

 
 
 
Шаг 5 Выбрав Remove driver and driver package (Удалить драйвер и пакет дравера), 
нажать кнопку OK. 

 

 
 

 

Шаг 6 Выбрать Yes, нажать кнопки Delete и OK. Установленный драйвер будет 

удален с компьютера. 
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2.8.2 Интерфейс RS-232 

 Подключение к порту RS-232 (последовательному) 

 
1. Для пользователей IBM PC, PS/2 и совместимых устройств: подключить 

кабель RS-232C к нужному последовательному порту (COM1 или COM2) 

главного компьютера. 

 

2. Настроить параметры обмена данными Baud Rate (Скорость бит/с) и Data 

Bits/Parity (Кол. бит /четность) в соответствии с параметрами ПО. См. 

раздел 3 — описание клавиши Misc. 
 

 
 

2.8.3 Ethernet-соединение 
 

I. Настройка сетевого подключения 

 
Шаг 1 Соединить порт LAN и порт Ethernet режущего плоттера GCC Ethernet-

кабелем RJ45 и включить устройство. 
 

  

Осторожно! Отключить плоттер перед подсоединением кабеля RS-232C. 
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Шаг 2 Нажать On/Off line, затем кнопку MISC на панели управления. 
 

 
 

Шаг 3 На вкладке DHCP кнопками со стрелками вверх и вниз выбрать Enable 

и нажать ENTER. 
 

  
 
 

Шаг 4 IP-адрес будет автоматически выведен на экран. Его необходимо записать. 
 

 
 
 
 

 
II. Настройка подключения Ethernet 

 
Имеется два способа вывода файлов через Ethernet. Если файл создан 

в GreatCut, придерживайтесь инструкции I. Вывод через GreatCut. Если файл 

создан в Adobe Illustrator or CorelDRAW, придерживайтесь инструкции II. Вывод 

через драйвер Ethernet.

1 

2 
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GreatCut — программный модуль для CorelDRAW и Illustrator. (Инструкции по 

установке GreatCut см. в разделе 2.9.1) 

 
Настройка Ethernet для GreatCut 

 
 

Шаг 1 Открыть GreatCut, создать новый файл и линию реза. 
 

 

Шаг 2 В разделе Settings найти Output Devices (Устройства вывода). 
 

 
 

Шаг 3 В списке Driver окна Setup Device выбрать нужную модель 
 

 

I. Вывод через GreatCut 
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Шаг 4 В поле TCP/IP ввести IP-адрес, скопированный с панели управления. 

Завершить настройку кнопкой ОК. 

 
 

Шаг 5 В меню File выбрать Output и проверить параметры. 
 

  
 
 

Завершить установку драйвера. Теперь для режущего плоттера GCC доступны 

сетевые подключения. 

 

Примечание Чтобы добавить новое локальное устройство, в окне Settings 

перейти в раздел Output Devices и выбрать Add local device (если 

устройство установлено, но нужно выбрать другое устройство, 

нажать Change и указать IP-адрес другого устройства). 
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Шаг 1 Подсоединить кабель Ethernet к компьютеру и установить драйвер Cutter 

Ethernet. Продолжить кнопкой OK. 
 

 
 

Шаг 2 Ввести IP-адрес с панели управления и выбрать модель (см. раздел 1 

настоящего руководства). 
 

 

II. Вывод через драйвер Ethernet 
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Шаг 3 Драйвер установлен. Теперь можно отправлять на вывод файлы из AI 

и CorelDRAW. 

 

 
 

 
2.8.4 Передача данных 

 

Передать данные с компьютера на режущий плоттер можно двумя способами: 
 

Вариант 1.  При правильно настроенных параметрах можно передавать данные  

из программы прямо на режущие плоттеры. 

 
Вариант 2. Практически все программы поддерживают эмуляцию команд HP-GL 

и HP-GL/2. Если файл в формате HP-GL или HP-GL/2, ошибки при 

выводе на режущем плоттере исключены. 

 
 
 

2.8.5 Настройка общего доступа 
 

На компьютере A-PC настроить драйвер принтера как общий принтер, затем 

использовать компьютер B-PC для подключения драйвера принтера A-PC через 

Интернет. 

 
 

 

Интернет 

Порт USB COM 

A-PC B-PC 
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Шаг 1 

На компьютере A-PC настроить драйвер принтера как общий принтер. Щелкнуть 

правой кнопкой мыши на значке принтера, выбрать Printer properties (Свойства 

принтера). Нажать Sharing (Общий доступ), затем Share this printer (Общий доступ 

к принтеру). 

  
 
 

Шаг 2 

На вкладке Advanced выбрать Print directly to the printer. 
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Шаг 3 

Отправить задание на устройство, чтобы проверить, подключен ли к устройству 
компьютер A-PC. 

 

 
 

 
 
 
 
 

Шаг 4 

Активировать драйвер принтера для компьютера A-PC через сеть B-PC. 
 

   
 
 
 
 
 
 

 
Шаг 5 

Правой кнопкой мыши щелкнуть на значке принтера и выбрать Connect (Подключить) 
для принтера A-PC. 

 

 

Отправить 

задание, чтобы 

проверить 

работу порта. 
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2.9 Установка программ 

 
2.9.1 Установка GreatCut 

 

Шаг 1 На установочном диске выбрать опцию GreatCut Registration. 

На веб-сайте http://gccvoucher.eurosystems.lu/ ввести код с купона,  

полученного при покупке GreatCut, и нажать Go on! 
 

 
 

 
 
 

Шаг 2 Кнопкой Request (Запрос) перейти на страницу регистрации. 
 

 
 

 

Шаг 3 Ввести нужную информацию и щелкнуть на кнопке Request license code 

(Запросить код лицензии). 

http://gccvoucher.eurosystems.lu/
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Шаг 4 Регистрация завершена. По электронной почте будет отправлено два 

сообщения: первое с подтверждением регистрации и ссылкой для 

активации, второе — с данными лицензии в формате .ecf. 

 
 

Шаг 5 Получив письмо с ссылкой для активации, щелкнуть по ссылке и скачать 

программу GreatCut. 
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Шаг 6 Или выбрать Install GreatCut из меню установочного диска DVD. 
 

 
 

Шаг 7 Указать папку для установки. 
 

 

 
Шаг 8 Установив переключатель Typical (Стандартная установка), нажать Next. 

Примечание. Для установки дополнительных драйверов выбрать Сustom 

(Пользовательская установка). 
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Шаг 9 Указать нужную папку и щелкнуть на кнопке Next. 

Папка для установки по умолчанию в меню Пуск: GCC\GreatCut 3. 
 

 
 

Шаг 10 Программа GreatCut устанавливается на компьютер. 
 

 

Шаг 11 Завершить установку щелчком на кнопке Finish. 
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Шаг 12 Не запуская программу GreatCut, открыть файл .ecf, приложенный к 

письму с данными по лицензии. Необходимая информация будет 

автоматически добавлена в GreatCut, и ее не придется вносить повторно. 
 

 
 

 

Шаг 13 Если лицензию установить не удалось, поля заполняют вручную. Вся 

нужная информация находится в электронном сообщении. 
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Шаг 14 Программа GreatCut готова к работе. 
 

 
 
 

 
2.9.2 Установка Sure Cuts A Lot (приобретается дополнительно) 

 

2.9.2.1 Автоматическая установка 
 

Шаг 1 Вставить установочный диск DVD в устройство чтения компакт-дисков. 

Программа совместима с Windows 7 и выше, Macintosh OSX 10.6 и выше. 

 

Шаг 2 Для запуска установки выбрать Sure Cuts A Lot. 
 
 

 

Шаг 3 Для продолжения нажать кнопку Next. 
 

 
 
 

Шаг 4 Установить флажок I accept the agreement (Принимаю соглашение) 
и нажать Next. 
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Шаг 5 Принять предложенную по умолчанию папку установки или выбрать 

другую папку для установки и нажать Next. 
 

 
 
 

Шаг 6 Для создания значка программы на рабочем столе установить  

флажок Create a desktop icon. Чтобы по умолчанию открывать файлы 

с расширением scut4 программой Sure Cuts A Lot, установить флажок 

Associated scut4 extension. Запустить установку, нажав Next. 
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Шаг 7 Не следует устанавливать флажок Install USB Driver (Установить драйвер 

USB). Установить флажок Launch Sure Cuts A Lot (Запустить Sure Cuts 

A Lot) и завершить установку кнопкой Finish. 
 

 

Шаг 8 Запустить программу Sure Cuts A Lot. 
 

 

Шаг 9 Для активации программы Sure Cuts A Lot нажать Activate… 

Предварительно следует убедиться в наличии доступа к Интернету. 
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Шаг 10 Указать имя в графе Name и ввести в поле Serial (Серийный номер) код 

из 25 символов, указанный на обложке диска DVD. Завершить активацию 

кнопкой OK. 
 

 
 

 
 

Шаг 11 Программа Sure Cuts A Lot готова к работе. 
 

 
 
 

 

Примечание 

 Если для вывода изображений используется пробная версия 

(не введен ключ для активации программы Sure Cuts A Lot, как 

описано выше), плоттер прорежет на материале две лишние линии. 

До отправки файлов на резку необходимо убедиться, что лицензия 

Sure Cuts A Lot активирована. 



Серия RX II. Руководство 

Установка 2-41 

 

 

 

 

2.9.2.2 Активация программного обеспечения вручную 
 

Если на компьютере, подключенном к плоттеру, отсутствует доступ к Интернету, 

для завершения активации и работы с программой можно выбрать Activate 

manually и ввести код активации. Для этого следует найти компьютер с доступом 

к Интернету и заранее получить код активации, следуя инструкции ниже. 

 

Шаг 1 Установить флажок Activate manually, чтобы вывести на экран поля Site 

Code (Код сайта) и Activation Code (Код активации). В поле Site Code уже 

есть данные, которые нельзя изменить. 
 

 
 
 

Шаг 2 На компьютере с доступом к Интернету открыть веб-страницу 

http://www.craftedge.com/activation/surecutsalot . Ввести имя, серийный номер 

(ключ программного обеспечения с обложки диска DVD) и код сайта (Site 

Code). 

 
 
 
 
 
 
 

Шаг 3 По щелчку на кнопке Generate Activation Code (Генерировать код активации) 

в поле Activation Code появится код активации. 

http://www.craftedge.com/activation/surecutsalot
http://www.craftedge.com/activation/surecutsalot
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Шаг 4 Код активации необходимо скопировать и вставить в диалоговое окно 

активации Sure Cuts A Lot, подтвердив кнопкой ОК. 
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2.9.2.3 Повторная установка Sure Cuts A Lot 
 

В случае замены компьютера может потребоваться деактивация программы Sure 

Cuts A Lot с повторной установкой на новом устройстве. 

 
Для этого выполнить Deactivate… из меню Help и подтвердить действие кнопкой 

Yes. Затем программу устанавливают на новом компьютере и активируют 

с помощью того же кода. 
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2.10. Установка системы автоматического отреза 

Шаг 1 Отвинтить крышку с каретки с помощью отвертки (рис. 2-31 и 2-32). 

 
 

Рис. 2-31 Рис. 2-32 
 

Шаг 2 Снять крышку, которая теперь держится на каретке только на проводах  

(рис. 2-33 и 2-34). 

 
 

Рис. 2-33 Рис. 2-34 
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Шаг 3 Снять крышку полностью, отсоединив черный и красный провода между 

крышкой и кареткой от белой соединительной муфты (рис. 2-35 и 2-36). 

Примечание. При отсоединении белой муфты соблюдать осторожность, чтобы 

не нарушить работу вентиляторов. 
 

 
 

Рис. 2-35 Рис. 2-36 

Шаг 4 Снять винт с левой части блока отреза (рис. 2-37 и 2-38). 
 

 

Рис. 2-37 

Фиксатор ножа 

Винт 

Рис. 2-38 

Муфта 
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Толкнуть влево 

Пластина 

Рис. 2-39 

 

Шаг 5 Демонтировать весь блок отреза, удерживая его и одновременно смещая 

влево небольшую металлическую пластину справа (рис. 2-39 и 2-40). 

 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-40 
 
 
 
 
 
 
 
 
 
 

Рис. 2-41 
 
 
 
 
 
 
 

Если толкнуть пластину влево, блок отреза отделится автоматически (рис. 2-41). 

 
 

Толкнуть влево 
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Шаг 6 Снять винт блока отреза (рис. 2-42 и 2-43) и демонтировать фиксатор ножа 

отреза, потянув его вверх (рис. 2-44). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-42 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

Рис. 2-43 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-44 

Винт 
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Шаг 7 Отвинтить отрезной нож от фиксатора, на котором он держится с помощью 

магнита. С помощью щипчиков установить новый нож вдоль паза, отмеченного 

красным цветом (рис. 2-45 и 2-46). 

 

Примечание. Отрезной нож очень острый. Обращаться осторожно. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-45 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 
Рис. 2-46 

Новый отрезной нож 

Старый отрезной нож 

Магнит 
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Шаг 8 Присоединить фиксатор отрезного ножа к блоку отреза, толкнув держатель 

вверх (рис. 2-47 и 2-48) и прикрутив винт (рис. 2-49). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-47 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-48 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Рис. 2-49 



Серия RX II. Руководство 

Установка 2-50 

 

 

Толкнуть влево 

 

Шаг 9 Присоединить фиксатор отрезного ножа к каретке, нажимая на 

металлическую пластину справа и одновременно толкая блок отреза вверх  

(рис. 2-50 и 2-51). Прикрутить винт (рис. 2-52). 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-50 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-51 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-52 
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Шаг 10 Снова подсоединить провода через белую соединительную муфту (рис. 2-53). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-53 
 
 

Шаг 11 Установить на место и закрепить крышку каретки. Для этого вставить 

кончик винта в отверстие и затянуть винт (рис. 2-54). 

 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 2-54 

Кончик винта 



Серия RX II. Руководство 

Панель управления 3-1 

 

 

 
 

 

 
 

В этом разделе описаны функции кнопок и экранных меню плоттеров серии RX II. После 

подготовки режущего плоттера к работе согласно разделам 1 и 2 для всех функций 

установлены параметры по умолчанию. 

 
3.1 Сенсорная панель 

 

 

<Сенсорная панель на плоттере серии RX II> 
 
 

Клавиша Функция 

ЖК-дисплей Для вывода функций и сообщений об ошибках 

Индикатор 
питания 

Состояние (горит — питание включено; не горит — отключено) 

Клавиши-стрелки Для смены положения, выбора функции и изменения настроек 

ENTER Для настройки и подтверждения последнего значения 

PAUSE/RESUME Для приостановки и возобновления резки 

ON/OFF LINE Для переключения режима, остановки резки, отмены изменений 
в параметрах. 

OFFSET Для регулировки смещения ножа 

FORCE Для регулировки усилия реза 

SPEED Для регулировки скорости и качества реза 

Раздел 3. Панель управления 
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CUT TEST Для проверки реза на различных материалах 

CUT OFF Для отрезания материала после завершения задания 

MISC Для настройки функций 

TOOL SELECT Для выбора инструментов 

DATA CLEAR Для очистки буфера памяти 

Подробнее см. в разделе 3.4 «Пункты меню» 
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3.2 Меню в онлайн-режиме 
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3.3 Меню в автономном режиме 
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3.4 Пункты меню 

Ниже описаны функции пунктов меню 
 

Меню или 
клавиша 

Функция Параметр Исходн. 

--- Размер материала --- 

Roll Замер ширины материала. Длина до 150 м  

Edge Замер ширины материала и протяжка материала назад 

до открытия фронтального датчика бумаги. 
Длина до 150 м  

Single Замер ширины и длины материала. Длина до 10 м  

--- POWER --- 

 Оповещение о состоянии   

[ Кнопки со стрелками ] 

 1. Перемещение каретки с инструментом по оси X или Y. 

2. Выбор функций и изменение значений параметров. 
  

[ ENTER ] 

 1. Отображаемые параметры сохраняются 
автоматически. 

2. Задание текущего положения каретки в качестве 

исходной точки. В режиме offline передвинуть каретку 

в нужное положение [клавишами со стрелками], после 

чего клавишей ENTER задать новую исходную точку. 

При перемещении с отображением параметров по 

осям XY нажать клавишу [MISC] для прецизионного 

перемещения. Для отключения функции снова нажать 
[MISC]. 

  

[ PAUSE/RESUME ] 

 Приостановка процесса резки. 

Чтобы возобновить резку, нажать [Pause/Resume] 
повторно. 
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[ ONLINE/OFFLINE ] 

 1. Переключение между активным и автономным 
режимами. 

2. Остановка резки или сброс изменений 

в параметрах. При нажатии клавиши задание реза 

немедленно прерывается и не может быть 

возобновлено. 

  

[ OFFSET ] 

 Задание или изменение расстояния между острием ножа 

и центральной осью. Клавишами с левой или правой 

стрелками выбирают нужный нож (красный, зеленый, 

желтый, синий, черный или перо). Затем настраивают 

величину смещения, нажав Enter, если необходимо. 

от 0,000 до 
1000 мм 

0,275 мм 

[ FORCE ] 

 Задание или изменение усилия инструмента. 

При усилии реза более 450 г, скорость реза не должна 

быть выше 30 см/с (Small Letter). При усилии реза 300–

449 г скорость должна быть 30 см/с в режиме Fine. 

от 5 до 600 г 

шаг 5 г 

80 г 

[ SPEED ] 

Speed Задание или изменение скорости перемещения 
инструмента по горизонтали. При скорости реза свыше 72 
см/с, качество устанавливают на Normal. 

от 3 до 153 

см/с; шаг 3 см/с 

72 см/с 

Up Speed: Задание или изменение скорости перемещения 
инструмента по вертикали. 

от 3 до 153 

см/с; шаг 3 см/с 

72 см/с 

Quality Задание или изменение качества резки. 

Для мелких букв установить значение Small letter. Для 

большой скорости установить значение Draft. В обычном 

режиме установить значение Normal. 

Режимы 

Draft, Fair, 

Normal, 

Fine, Small 

Letter 

Стандарт 

[ CUT TEST ] 

Square Cut Тестирование резки с текущим положением ножа. 

Подробнее о регулировке усилия ножа и скорости реза 

см. в разделе 4.3. «Усилие реза и регулировка 

смещения». 

  

Repeat AAS 

Job 

Для автоматического повторения задания из AAS без 

отправки с компьютера. 

Внимание: функция обычно применяется для режима 

бумаги Single. Перед запуском убедитесь, что загружен 

новый материал и в качестве исходной точки задана 

первая приводочная метка. По окончании задания AAS 

пользователю будет предложено на выбор повторить 

задание (Repeat AAS Job Again) или вернуться в 

главное меню, нажав Online/Offline. 

  

Pattern Setting Два режима тестового реза 

Примечание. Для толстых материалов рекомендована 

опция Cross. 

Элементы 

Arrow 

(стрелка) и 

Cross (крест). 

Arrow 

Ratio Setting Для настройки размеров элемента 100%, 200%, 

300%, 400% 

100% 

Blade Length 

Adjust 

Регулировка длины выступающей части ножа.  

1. До начала регулировки высота ножа должна 
составлять 0. 

2. Сначала проверяется держатель ножа, затем 

нажатием ENTER запускается тест высоты ножа. 

3. При проверке держателя ножа и высоты 

выступающей части держатель должен оставаться 

в одном положении. 

4. По завершении проверки держателя и высоты ножа 

от 0,00 до 5,00 
мм 

0.00mm 
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     на экране будет показано, на сколько (величина 

после обозначения CW или CCW) и в каком 

направлении [CW (по часовой стрелке) или CCW 

(против часовой стрелки)] повернуть регулировочную 

головку. 

Turn CW 0.5: повернуть головку на 5 делений по 

часовой стрелке. 

5.   Если значение на экране 0.0, высота ножа оптимальна 

и не требует корректировки. Система выдаст 

подсказку в сообщении: Adjustment completes and you 

may start cutting at this point. 

  

Redo Jobs 

in Memory 

Для повторного выполнения сохраненного в памяти 

тестового задания: повторный рез или получение 

тестовых копий. 

Recut (число 

повтором: 1-99) 

 
Copy (число 

заданий: 1-999) 

Recut 

[ DATA CLEAR ] 

 Для очистки буфера памяти.   

[ TOOL SELECT ] 

Set Smoothing 

Cut Select: 

Включение функции плавной резки.  Enable 

Over Cut Резка с нахлестом для удобного отделения облоя. От 0,00 до 1,00 

мм с шагом 

0,05 мм 

0.00mm 

Set 

Tangential 

Mode 

Активация тангенциального режима для толстых 

материалов и мелких букв. 

Примечание: при значении Offset, установленном 

на 0,000 мм, меню Set Tangential Mode недоступно. 

 Enable 

Pouncing Получение перфорированных контуров. 

* Для использования функции необходим 
перфорирующий инструмент. 

* Перед запуском перфорации защитить марзан, 

положив на него специальную ленту. 

* Для отключения режима значение устанавливают на 0 
мм. 

* Инструмент для перфорации приобретается 
дополнительно. 

от 0 до 200 мм 0mm 

Настройка 
панели 

Accept setup command: 

Ввод команд Force, Speed, Cutting Quality и Offset 

только из программы. 

 Accept 

setup 

command 
 Control panel only: 

Ввод команд Force, Speed, Cutting Quality и Offset 

только с панели управления плоттера. 

  

Restore Default Сброс всех параметров меню до заводских настроек.   

Save 

Parameter 

Сохранение параметра (параметров) резки для 
последующего использования. 

На панели сохраняются 4 набора параметров. 

Клавишами Page Up и Page Down выбрать нужный набор 

параметров, нажать Enter для подтверждения (число 

в левом верхнем углу при этом изменится). В набор 

параметров входят: Speed (скорость), Force (сила), Offset 

(смещение), Up Speed (скорость по вертикали), Quality 

(качество), Scaling (масштаб). Три последних в этом 

разделе не отображаются. Для корректировки или 

проверки отдельных значений вернитесь с помощью 

соответствующих клавиш панели и нажмите Enter для 

подтверждения. 

Схема 1: 

винил 

 
Схема 2: 

тонирование 

витрин 

 
Схемы 3 и 4: 

значение по 

умолчанию, 

необходимо-

сти можно 

изменить 

Схемы 3 

и 4 

[ MISC ] 
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Auto Unrolled 

Media 

Предотвращение затора бумаги и отказа двигателя 

путем автоматической размотки материала (50 см 

и более) перед началом резки.  

* Автоматическая размотка действует только с рулонами. 

* При переходе в режим Single функция автоматически 

отключается. 

* Если в рулоне меньше 2 м материала или он мало 

весит, функцию рекомендуется отключить. 

 Enabled 

Auto Unrolled 

Media 

Для регулировки скорости размотанного материала. Slow, Normal, 

Fast 

Slow 

Rear 

Paper 

Sensor 

Определение доступности бокового датчика бумаги. 

Если режим активирован, плоттер распознает, перекрыл 

ли материал боковой датчик бумаги в режимах Roll и 

Edge. При отключении боковой датчик работать не будет. 

Примечание. Боковой датчик бумаги функционирует 

только в режимах Roll и Edge. 

Enable 

Disable 

Enable 

Image 

Scaling Width 

Регулировка масштаба изображения по отношению 

к длине и ширине материала с учетом толщины 

материала. 

Числитель — идеальная длина, знаменатель — 

реальная длина по факту. 

 

Пример: резка линии длиной 500,0 мм. Процедура: 

1. Нажатием [СТРЕЛКИ ВЛЕВО] выбрать числитель и 

500.0 mm. 

2. Отправить графический файл для резки 

3. Измерить длину, затем [СТРЕЛКОЙ ВПРАВО] 

выбрать знаменатель, 

4. Нажатием [СТРЕЛКИ ВВЕРХ / СТРЕЛКИ ВНИЗ]  

      изменить значение фактической длины 

  

Image 

Scaling 

Length 

  

Scale Width Фиксированный масштаб, только для технического 
обслуживания. 

  

Scale Length 

MAC Address MAC-адрес режущего плоттера.   

IP Address IP Address IP-адрес режущего плоттера.   

DHCP Ваш IP-адрес для конфигурации TCP/IP  Disable 

Select Units Четыре системы измерения для удобства пользователя. cm/s; inch/oz; 
cm/oz; inch/gram  

 

Metric  

 

Select 

Language 

Выбор языка ЖК-панели: английский, испанский, 

итальянский, немецкий, португальский, польский, 

турецкий, 
французский или японский. 

 English 

Sizing Setting Для настройки размеров. 

При активации пользовательского режима при каждом 

включении устройства пользователь сможет задавать 

размер. В режиме Default Roll после включения 

устройства будет определяться размер рулона. 

User Defined 

/Default Roll 

User 

Defined 

Firmware 

Version 

Версия встроенного программного обеспечения и код 

FPGA, которые меняются в зависимости от модели 

  

Set 

Communication 

Настройка обмена данными между компьютером 

и плоттером. 

Baud Rate определяет скорость передачи данных. 

Data Bits определяет размер одного блока данных. 

Parity — контроль корректности передачи данных.  

9600, n, 7, 1, p  9600 бит/с, 7 бит, БЕЗ контроля 

9600, n, 7, 1, p  9600 бит/с, 7 бит, НЕЧЕТНОСТЬ 
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     9600, n, 7, 1, p  9600 бит/с, 7 бит, ЧЕТНОСТЬ 

9600, n, 8, 1, p  9600 бит/с, 8 бит, БЕЗ контроля 

9600, n, 8, 1, p  9600 бит/с, 8 бит, НЕЧЕТНОСТЬ 

9600, n, 8, 1, p  9600 бит/с, 8 бит, ЧЕТНОСТЬ 

19200, n, 7, 1, p  19200 бит/с, 7 бит, БЕЗ контроля 

19200, n, 7, 1, p  19200 бит/с, 7 бит, НЕЧЕТНОСТЬ 

19200, n, 7, 1, p  19200 бит/с, 7 бит, ЧЕТНОСТЬ 

19200, n, 8, 1, p  19200 бит/с, 8 бит, БЕЗ контроля 

19200, n, 8, 1, p  19200 бит/с, 8 бит, НЕЧЕТНОСТЬ 

19200, n, 8, 1, p  19200 бит/с, 8 бит, ЧЕТНОСТЬ 

  

Paper 

Saving Mode 

Четыре режима экономии материала: 

1. Увеличение длины 2. Увеличение ширины 

3. Увеличение длины и ширины 4. Без увеличения 

 Length 

expanded 

mode 

First Back to 
Origin 

Возвращение каретки в предыдущую исходную точку. 

При выборе Enable каретка не вернется в предыдущую 

точку. При выборе Disable каретка вернется  

в предыдущую точку. 

Enable 

Disable 

Enable 

AAS Copy Подключение копирования AAS. При выборе Enable 

модуль AAS продолжит считывание приводочных меток 

для контурной резки. Пользователь может задать 

расстояние между изображениями и количество копий 

AAS. Диапазон расстояний от 0 до 500 мм, количество 

копий от 0 до 1000. 

Enable 

Disable 

Enable 

AAS Offset Для настройки и изменения смещения AAS. 

Подробнее см. «5.3. Тестирование печати». 
  

Vacuum Включение вентиляторов для оптимизации 

отслеживания и точности реза. При отключении 

вакуума вентиляторы будут бездействовать в режиме 

резки и графопостроения. 

Enable 
Disable 

Enable 

Auto Unrolled 
Length 

Для регулировки длины размотанного материала. от 500  
до 3000 мм 

500 мм 

[ CUT OFF ] 

 Для автоматического отреза материала по завершении 

задания клавишами со стрелками подвести каретку 

к нужной точке, чтобы отрезать материал вручную 

и нажать кнопку CUT OFF. 
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Датчики 
бумаги 

Рис. 4-2 

 
 

 
 

 

4.1 Загрузка материала 

 
4.1.1 Загрузка листового материала 

Для правильной загрузки материала выполнить перечисленные ниже шаги: 
 
 

Шаг 1 

Рычагом с верхней правой стороны режущего плоттера поднять или опустить нижние 

прижимные ролики. Потянуть рычаг вперед до щелчка, чтобы поднять ролики (рис. 4-1). 

 
 
 
 

Рычаг 
 
 
 
 
 
 
 
 

 
Шаг 2 

 

Рис. 4-1 

Наложить материал на опорную пластину и протолкнуть его под прижимные ролики 

спереди или сбоку. Для выравнивания материала на опорной пластине имеются 

приводочные линейки. 

 
 

 

Примечание. 

При загрузке материала 

убедиться, что он перекрыл 

датчики бумаги на опорной 

пластине. Должны быть 

перекрыты как минимум два 

датчика бумаги (рис. 4-2). Как 

только материал перекроет 

датчики, режущий плоттер 

автоматически определит 

длину и ширину материала. 

Раздел 4. Эксплуатация 
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Белые метки 

 

Шаг 3 

Вручную переместить прижимные валики в нужное положение. Прижимные валики 

должны находиться на решетчатом барабане. Определить положение барабанов можно 

по белым меткам на верхней станине (рис. 4-3). 

 
 
 
 
 
 
 
 
 
 

 

Рис. 4-3 
 
 
 

Шаг 4 

Отвести рычаг назад, чтобы опустить прижимные ролики. 
 
 

Шаг 5 

Включить питание. Каретка инструмента автоматически определит размер материала. 

Режущий плоттер начнет работать. 
 
 
 
 
 
 
 
 
 

 

 
 

Рис. 4-4 

 
 
 
 
 

 
(X) 

Неправильно 

Примечание. 

1. Регулировку положения проводить только с поднятым прижимным роликом. 

2. Для перемещения прижимного ролика нажать на торец опоры ролика. 

3. Не перемещать ролик за переднюю прорезиненную часть (рис 4-4). 



Эксплуатация 4-3 

Серия RX II. Руководство 
 

 

 

 
 

 
 

 
 
 
 

4.1.2 Загрузка рулонного материала 
 

Шаг 1 

Направляющие втулки держателя поместить на два держателя (рис 4-6). 
 

 

Примечание. 

Для правильного определения ширины материала сначала поднимают все 

прижимные ролики (рис. 4-5) и только потом толкают рычаг. 
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Шаг 2 

— Вариант А (с фланцами для рулона) (Рекомендовано) 

Вставить с обеих сторон рулона фланцы в сердечник рулона и плотно затянуть 

винтами ручной затяжки, зафиксировав рулон (см. рис. 4-7). 

 
Установить рулон с материалом на держатели. Отрегулировать положение рулона 

так, чтобы фланцы проворачивались в проточках направляющих втулок (рис. 4-8). 

 
 
 
 
 
 
 
 
 
 
 
 

 
Рис. 4-7 

Рис. 4-8 

 
 
 
 
 
 
 
 
 

— Вариант B 

Вставить два держателя рулона в опорный узел, затем поместить рулон между 

двумя держателями (рис 4-9). 

 
 
 
 
 
 
 
 
 

 

Рис. 4-9 
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Шаг 3 

Загрузить материал в устройство так, чтобы край рулона лег на опорную пластину.  

См. «4.1.1. Загрузка листового материала». После загрузки рулона расправить 

материал на опорной пластине и надежно зафиксировать переднюю кромку рулона 
 

  
 

Шаг 4 

Провернуть рулон в направлении намотки, добившись 

равномерного натяжения материала (рис. 4-11) 

 

 

Передвинуть прижимные ролики в нужное положение. Они 

должны обязательно находиться над решетчатыми 

барабанами. 

 

 

Отвести рычаг назад, чтобы опустить прижимные ролики. 
 
 

Шаг 7 

Направляющие втулки держателя поместить на два держателя, зафиксировав рулон. 
 
 

Шаг 8 

Включить питание и выбрать нужный режим для настройки (Roll, Edge или Single) или 

задать настройки по умолчанию (Default). Параметры Roll in Sizing и Roll Type sizing 

задаются после включения плоттера. Режущий плоттер готов к работе. 

 

Шаг 9 

Для снятия материала выполнить шаги в обратном порядке. 

Шаг 6 

Шаг 5 

Рис. 4-11 

(рис. 4-10). 

Рис. 4-10 

Прим. 

Убедиться, что материал 

натянут равномерно 

по всей ширине. 

Провисание материала 

на опорной пластине 

приведет к проблемам 

с отслеживанием! 
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4.2 Отслеживание 

 
Чтобы обеспечить качество отслеживания для длинных макетов, рекомендуется 

соблюдать правила загрузки материала, изложенные ниже. 

 
При длине материала менее 4 м оставляют поля от 0,5 до 25 мм от левой и правой 

кромок материала (рис 4-12). 

 
 
 
 

 
 
 

 
При длине материала более 4 м оставляют поля не менее 25 мм от левой и правой 

кромок материала (рис 4-13). 

 
 

 

 
 
 
 
 

Подробнее см. раздел 4.5 «Как получить длинномерное изделие». 

от 25 мм от 25 мм 

Рис. 4-13 

0,5–25 мм 0,5–25 мм 

Прижим Прижим 

Рис. 4-12 
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4.3 Усилие реза и регулировка смещения 

 
Чтобы получить хорошие результаты резки, до отправки дизайна на плоттер можно 

провести тестирование. Функцию Cut Test повторяют до получения нужного результата 

на материале. 

 
После измерения материала нажать кнопку [CUT TEST], выбрать square cut 

и подтвердить клавишей [ENTER]. 

 
Сила реза и величина смещения по умолчанию составляют 80 г и 0,275 мм, 

соответственно. Клавишами со стрелками переместить каретку в нужную позицию. 

Клавишей [ENTER] запустить тестовый рез. 

 
Примечание. При тестовом резе одновременно задается новая исходная точка. 

 

Плоттер вырежет нужный макет. Следует проверить, насколько легко облой отделяется 

от материала. Если легко, усилие реза выбрано верно. Если облой не отделяется или 

прорезан, клавишей [FORCE] отрегулировать усилие инструмента до получения нужного 

результата (рис. 4-14). 

 
Если получен результат типа BB или CC, 

следует регулировать смещение 

клавишей [OFFSET] до получения 

результата AA. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4-14 

S  q  u  a   r   e C  u   t 

S  e   l   e  c   t   : O K  :   E  n   t   e   r 

M o  v  e c  u   t t   e   s   t M 
X  : Y  : 

C  o  n   t   i   n  o  u  s S  q  u  a   r   e C  u   t 
N  :  O  N  /   O F  F  L I NE    O K  :   E  n   t   e   r 

Машина 

Нажать ENTER 
 

Нажать ENTER 
 

AA BB Ко
пи
и 

Нажать ENTER 
 

Нажать SPEED_KEY, 
FORCE_KEY, 

OFFSET_KEY или 

клавишами со стрелками 

задать положение для 

следующего квадратного 

реза. 

 

Завершить 
квадратный рез 

Нажать 
ENTER_KEY 

 

Нажать ON/OFF 

line_KEY 

3 мм 3 мм 

80
 м

м
 

80
 м

м
 

80
 м

м
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4.4 Как вырезать буквы в 3 мм 

 
Для получения качественного результата рекомендуется брать узкие материалы. 

При работе с широкими материалами: 

1. Расположить два прижимных ролика как можно ближе с двух сторон области 

реза. 

2. Убедиться, что материал выровнен, натяжение равномерное по всей ширине 

опорной пластины. 

3. Рекомендованные настройки: 

Усилие реза: 55 г (или в зависимости от материала) 

Скорость реза: 45–50 см/с 

Скорость инструмента: 45–60 см/с  

Плавный рез: Disable 

Quality: Small Letter 
 
 

4.5 Как получить длинномерное изделие 

 
Для резки длинномерного изделия из рулона тяжелого и широкого винила или бумаги 

использовать функцию AUTO UNROLL MEDIA. Для получения наилучшего качества 

рекомендованы следующие параметры. Качество результата может отличаться для 

разных материалов. 

1. При длине макета от 3 до 5 м: скорость реза — менее 72 см/с, 

качество реза — Normal. 

2. При длине макета от 5 м и сложном для резки материале скорость 

реза рекомендуется еще снизить. 

3. После загрузки рулона расправить материал на опорной пластине 

и надежно зафиксировать переднюю кромку рулона (рис. 4-15). 

 
 
 
 
 
 
 

 
Рис. 4-15 
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Провернуть рулон в направлении намотки, добившись равномерного 

натяжения материала (рис. 4-16) 

 

 

4. Активировать прижимные ролики. 

5. Направляющие втулки держателя поместить на два держателя, 
зафиксировав рулон. 

6. Выступающая высота ножа должна быть больше толщины винила. 

(См. приложение «Параметры ножа: об инструменте».) Выполнив все шаги, 

можно приступать к изготовлению крупногабаритных изделий. 

 
4.6 Как закончить резку 

 
Закончив работу, поднять рычаг для загрузки листов и вынуть материал. Отрезать 

готовую продукцию удобно с помощью безопасного ножа (входит в комплект) вдоль 

направляющей (рис. 4-17). Или подвести каретку к нужной точке, чтобы отрезать 

материал вручную и нажать кнопку CUT OFF на панели управления. Материал будет 

отрезан автоматически. 

 
 
 
 

 
Рис. 4-17 

Рис. 4-16 

Убедиться, что материал 

натянут равномерно по всей 

ширине. Провисание 

материала на опорной 

пластине приведет к 

проблемам с отслеживанием. 
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4.7 Настройка драйвера печати RX II 
 

4.7.1 Настройка драйвера печати RX II > Вкладка Option 
 

 
 
 

Настройка: перечисленные ниже параметры устанавливаются в зависимости 

от приложения и желаемых результатов. 

 
Quality: 

[Ниже скорость / выше качество - Выше скорость / ниже качество] 

Параметр Cutting Quality задает соотношение качества и скорости в зависимости 

от конкретного задания. Режим Draft — самая высокая скорость в ущерб качеству. 

Режим Small letter — самое высокое качество в ущерб скорости. Необходимо учитывать, 

что скорость и качество — понятия взаимоисключающие. 

 
Blade: 

Выберите тип ножа для конкретного задания. 
 

Use Plotter Setting: 

Параметры будут соответствовать введенным с панели управления. 
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Back to home: 

При установке флажка каретка будет возвращаться в исходную позицию. 
 

Auto Cut off: 

По окончании работы плоттер отрезает материала. Это упрощает эксплуатацию резака 

без оператора на больших объемах заказов. Материал будет отрезан автоматически 

при установке флажка Auto Cut в драйвере GCC. Здесь же настраивается расстояние 

между вырезаемым изображением и линией отреза. 

 
Значение по умолчанию — 10 мм: материал отрезается на расстоянии 10 мм 

от изображения. Значение функции отреза регулируется в диапазоне от 0 до 100 мм, 

в зависимости от задачи. 

 
 

Векторная функция 

1. Normal: 

Значение для векторной функции по умолчанию. Порядок резки зависит от порядка 

создания графики в программном приложении. 

 
 

2. X sorting: 

Порядок резки определяется следующим ближайшим объектов по оси X от 

исходной точки. В примере ниже порядок резки будем следующим: 1, 2, 3, 4 

(см. рис. 4-20). 

 
 
 
 
 
 
 
 
 
 
 

 

Рис. 4-19 

 
4 

2 

3 

1 
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3. Inside Out Cutting: 

При резке векторного макета, где у изображения есть зона резки, соприкасающаяся 

с другой зоной резки, выбирается режим Inside-out Sorting (сортировать изнутри 

наружу). В этом режиме драйвер печати автоматически обрабатывает внутреннее 

векторное изображение, затем переходит к наружному. Таким образом, режущий 

плоттер автоматически начинает с внутреннего векторного изображения, постепенно 

перемещаясь наружу. 

 
4. Cutting Path Optimization: 

Настройка, уменьшающая время обработки. При установке флажка драйвер 

принтера анализирует изображение и автоматически определяет самую 

эффективную траекторию его обработки. 

 
5. Section Cutting: 

Пользователи могут выводить длинномерные макеты посегментно. Результат будет 

стабильнее, а качество печати — выше. Сегменты можно настроить по приводочным 

меткам или ввести значения вручную. Закончив резку первого сегмента, плоттер 

перейдет ко второму. См. рис. ниже: 
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File Function (вкладка Option): 

Раздел для управления параметрами режущего плоттера. При повторяющихся работах 

это позволяет сохранить самые распространенные настройки и загружать их по мере 

необходимости. 

 
• Custom Media: Раздел содержит список недавно созданных и использованных 

файлов с параметрами настройки. Для удобства работы можно сохранять более 

50 файлов. 

 
• Default: В разделе содержатся эталонные настройки для проверенных материалов, 

обеспечивающие наилучшие результаты резки. Рекомендованные параметры могут 

нуждаться в корректировке в зависимости от поставщика материалов. 

 
• SAVE Сохраняет текущие настройки драйвера печати в файл в указанной папке 

компьютера. (Сохраненные файлы с параметрами помечаются расширением 

серии RX II) 

 
• LOAD: Загружает ранее сохраненные параметры драйвера печати. 

 

• ORIGINAL: Загружает исходные заводские параметры драйвера печати. 
 

• SAVE TO DEFAULT: Сохраняет текущие параметры драйвера печати как исходные 

параметры по умолчанию. 

 
• DELETE: Удаляет выбранный файл из раздела Custom Media. Настройки в разделе 

Default удалить невозможно. Внимание: функция удаляет только список, показанный 

в разделе Custom Media, не затрагивая файл .RX на жестком диске. Удалить файл 

с жесткого диска можно только вручную через операционную систему. 

 

 

Примечание. 

При работе с операционной системой Windows 2000 или XP для 

сохранения настроек режущего плоттера необходимо войти в систему 

с администратором или с правами администратора. 



Эксплуатация 4-14 

Серия RX II. Руководство 
 

 

 

4.7.2 Настройка драйвера печати RX II > Вкладка Pen 

В серии RX II 16 различных параметров реза, включая скорость реза и смещение ножа, 

представлены 16-ю различными цветами. Эти цвета называют «маркерами» (pens). 

Каждый маркер соответствует не только цвету макета, но и определенному параметру 

плоттера. Изображение, состоящее из черного, красного и синего цветов, будет 

обработано с настройками, присвоенными каждому из этих цветов. Чтобы использовать 

до 16 разных маркеров (параметров режущего плоттера), необходимо, чтобы 

графическая программа распознавала и использовала 16 цветов-маркеров, присвоенных 

драйвером печати GCC RX II (см. рис. 4-21). 

Рис. 4-21 

Чтобы назначить собственные цвета для определенного параметра плоттера, 

достаточно дважды щелкнуть на нужном цвете в меню маркеров. В окне менеджера 

цветов нажать «Define custom colors» и выбрать собственные цвета (см. рисунок ниже). 

Это удобно, если изображение состоит из цветов, которые не входят в меню маркеров 

по умолчанию. В этом случае вместо внесения изменений в макет достаточно присвоить 

настройки, соответствующие цветам изображения. 
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Рис. 4-22 
 
 

 

 
 
 
 

Speed (Скорость) на вкладке Pen [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 72cm/sec] 

Ползунок скорости управляет скорость реза в процессе работы плоттера при диапазоне 

от 3 до 153 см/с. Максимальная скорость реза для серии GCC RX II составляет 153 см/с. 

 
Force (Сила) на вкладке Pen [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 80g] 

Ползунок силы управляет усилием реза в процессе работы плоттера при диапазоне 
от 0 до 600 г. 

 

Offset (Смещение) на вкладке Pen [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 0.25mm] 

Ползунок смещения управляет смещением ножа с учетом выбранного типа ножа. 

Примечание. 

Драйвер устройств серии GCC RX II хранит не более 16 цветовых 

маркеров или различных параметров настройки в одном файле. 
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Die Cut (Высечка) на вкладке Pen 

Функция Die cut позволяет прорезать материал вместе с подложкой. Для этой функции 

доступны только первые 8 маркеров. Если выбрать маркер №1 и нажать Die Cut, маркер 

№9 станет маркером №1* для настройки другого параметра для той же линии реза 

(рис. 4-24). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Рис. 4-24 

 

При необходимости любой параметр, включая силу и длину, можно откорректировать для 

маркера №1 и маркера №1*. 

 
Пример: 

 

 

Рис. 4-23 
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Рис. 4-26 

Наклейка 
 
 
 
 
 
 

 
 
 

 

Image Scaling (Масштабирование изображения) на вкладке Pen 
 

Функция позволяет настроить масштаб изображения относительно длины и ширины 

материала, чтобы сократить разницу между фактической и оптимальной длиной 

из-за различия в материалах, которые используются для резки. 
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4.7.3 Настройка драйвера печати RX II > Вкладка Paper 
 
 

 
 
 

Paper Size (Формат бумаги) на вкладке Paper [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ:  

Y = ширина устройства; X рассчитывается автоматически умножением длины Y на два] 

 
Формат бумаги соответствует общей рабочей площади. Значение X соответствует длине, 

Y — ширине. Для лучшего качества реза формат бумаги должен соответствовать 

изображению. 

 
Unit (Единицы измерения) на вкладке Paper [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ:  
Metric (мм)] 

Для настройки стандартных единиц измерения, с которыми будет работать драйвер 

печати RX II, — метрических или дюймовых. 
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4.8. Рекомендованные настройки для различных материалов 

 
Параметры ниже используются для материалов из таблицы, сертифицированных GCC. 

 

 

Материал Настенные 
 наклейки 

Магниты Персонализирован. 
наклейки 

Витринный 
декор 

Нож красный зеленый красный красный 

Длина лезвия, мм 0,3 0,8 0,28 0,25 

Усилие, гс 95 580 105 95 

Скорость, см/с 72 3 72 65 

Смещение, мм 0,275 0,5 0,275 0,275 

 

 
Рекомендованная 
модель 

RX, Jaguar, Puma, 

EX-P, Bengal, EXII, 

AR-24 

 

 
RX, Jaguar 

RX, Jaguar, Puma, 

EX-P, Bengal, EXII, 

AR-24 

RX, Jaguar, Puma, 

EX-P, Bengal, EXII, 

AR-24 

Материал Наклейки на 
автомобили 

Светоотраж. 
пленка 

Картон 

Нож красный зеленый зеленый 

Длина лезвия, мм 0,27 0,5 0,3  

Усилие, гс 85 380 165  

Скорость, см/с 60 3 30  

Смещение, мм 0,275 0,5 0,5  

 

 
Рекомендованная 
модель 

RX, Jaguar, Puma, 

EX-P, Bengal, EXII, 

AR-24 

 
RX, Jaguar, Puma, 

EX-P, Bengal 

 
RX, Jaguar, Puma 

EX-P, Bengal, EXII, AR-24 

Материал Тонирование 
витрин 

Тонировочная 
защита 

Стразы 

Нож красный зеленый зеленый 

Длина лезвия, мм 0,09 0,3 0,8  

Усилие, гс 70 320 190  

Скорость, см/с 72 3 15  

Смещение, мм 0,275 0,5 0,5  

 

 
Рекомендованная 
модель 

RX, Jaguar, Puma 

EX-P, Bengal, 

EXII, AR-24 

 
RX, Jaguar, Puma, 

EX-P, Bengal 

 

 
RX, Jaguar, Puma 
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Внимание! Это глава представляет собой вводную инструкцию к AASII. Пошаговые 

инструкции приведены в следующих главах: 08_A-3 Модуль CorelDraw, 08_A-4 Модуль 

Illustrator, 08_A-5 Модуль GreatCut. 

 
5.1 Общая информация 

 
Серия режущих плоттеров RX II укомплектована стандартной системой автоматического 

выравнивания (AAS II), которая распознает приводочные метки на отпечатках, 

гарантируя точность реза. 

 

Внимание 

 �Избегать горизонтального освещения модуля AAS любым источником света. 
 
 
 
 
 
 
 
 

 
- ЗАПРЕЩАЕТСЯ - РАЗРЕШЕНО 

 
 
 

 ЗАПРЕЩАЕТСЯ снимать крышку модуля AAS в процессе работы. 
 

 

- ЗАПРЕЩАЕТСЯ 

Раздел 5. Автоматическое выравнивание 
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5.2 Система контурной резки AAS 

 
Исключительная точность работы системы AAS обеспечивается специальными 

калибровочными процедурами. Для работы с системой AAS необходимо уметь 

загружать материал (см. «4.1. Загрузка материала».) 

 
5.2.1 Примечание по приводочным меткам 

Первая приводочная метка должна отличаться, чтобы ее распознавала система 

AAS. На автоматическое считывание меток влияют следующие факторы. 

 Тип материала 

 �Расположение приводочных меток 

 �Диапазон считывания для распознавания приводочных меток 

 �Положение приводочных меток и материала 

Приводочные метки должны быть: 

 Созданы в программе для резки типа GreatCut или модуля GCC для 
CorelDRAW 

 Черного цвета (важно качество печати приводочных меток: неверные 

цвета, проблемы приводки, размытие, размазывание могут ухудшить 

результаты резки) 

 Length: длина меток 

Диапазон: от 5 до 50 мм 

Оптимально: 25 мм 

 Thickness: толщина линии меток 

 Диапазон: от 1 до 2 мм 

Оптимально: 1 мм 

 Поля: Расстояние между метками и изображениями 

 Диапазон: от 0 до 50 мм 

Оптимально: 5 мм 

Режущий плоттер не распознает метки, если: 

 Перед распознаванием каретку плоттера не подвели к внешней 

границе первой метки (зону автораспознавания первой приводочной 

метки см. на рис. 5-7.). 

 Средняя толщина более 0,8 мм. 

 Используется прозрачный материал. 

 Рисунок не монохромный. Отпечатанные на цветной поверхности 

метки не считываются. 

 Поверхность материала испачкана или измята. 
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5.2.2 AAS II для серии RX II 

В AAS II есть три схемы работы с метками: 4-Point Positioning (по 4 точкам), 

Segmental Positioning (по сегментам), Multiple Copies (создание копий). Перед 

печатью макетов на струйном принтере необходимо добавить к макету 

приводочные метки, созданные в программе для резки типа GreatCut или модуля 

GCC для CorelDRAW. Режущие плоттеры GCC не работают с рисунками и 

метками, сделанными от руки. Подробнее о настройке приводочных меток в 

программе резки см. «Приложение A-3: Инструкция по программному модулю 

CorelDRAW», «Приложение A-4: Инструкция по программному модулю 

Illustrator», «Приложение A-5: Инструкция по программному модулю GreatCut» и 

«Приложение A-6: Инструкция по SignPal 12». 

 
1. Позиционирование по 4 точкам 

Базовая схема автоматического распознавания приводочных меток в AAS II 

и контурной резки изображений внутри этих меток. 

 Команда: Esc.D1;(XDist);(YDist): 

 Компоновка: 4 приводочные метки по четырем углам вокруг дизайна. 

 

 
 
 

2. Позиционирование по сегментам 

К четырем исходным точкам добавляются промежуточные приводочные метки 

по осям X и Y для большой точности резки, особенно крупных изображений. 

 Команда: Esc.D2;(XDist);(YDist);(XStep);(YStep): 

 Компоновка: 

Промежуточное расстояние по оси X: от 200 до 600 мм, по умолчанию 300 мм 

Промежуточное расстояние по оси Y: от 200 до 600 мм, по умолчанию 300 мм 
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 Точная резка длинномерных макетов 
 

Для более качественных результатов серия RX II работает с секционной резкой. 

Объект обрабатывается по секциям с учетом настроек позиционирования 

по сегментам. 

Последовательность: Сегмент 1-> Сегмент 2-> Сегмент 3- > Сегмент 4 
 
 

 
 

3. Multiple Copies (Создание копий) 

Функция используется для тиражирования изображений, если нужно получить сразу 

несколько экземпляров. Датчик AAS II автоматически отсканирует приводочные 

метки для каждого отдельного изображения, обеспечив точность реза. 

 Команда: Esc.D3;(XCopies);(YCopies);(Space): 

 Компоновка: 
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5.2.3 Автоматическое определение направления макета 

 
Для удобства пользователей устройства серии RX II автоматически определяют 

направление подачи материала при контурной резке. На рис. 5-1 показана 

последовательность распознавания приводочных меток при стандартной подаче 

материала (1->2->3->4). На рис. 5-2 устройство RX II распознает приводочные метки 

(3->4->1->2) при подаче в обратном направлении. Плоттеры серии RX II распознают 

метки и выполняют контурную резку независимо от способа загрузки материала. 

 
Алгоритм распознавания направления: 

(См. рис. 5-2) 

a. Распознавание положения третьей приводочной метки 

b. Переход к четвертой приводочной метке для определения направления 

 

(Направление распознается по четвертой приводочной метке) 

c. Перед началом резки драйвер обрабатывает информацию 

d. Метки распознаны, идет выполнение задания 

 

(Последовательность   распознавания меток 3->4->1->2) 

 

  Рис. 5-1   Рис. 5-2 
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5.3 Пробная печать 

 
Перед выполнением контурной резки с системой AAS рекомендуется распечатать 

тестовый файл с установочного диска DVD, чтобы обеспечить точность реза на 

RX II. 

 
Для AASII предусмотрено два тестовых файла: 

1. AAS II_X_Y_Offset_Caberation_A4.eps (формат A4) 

2. AAS II_X_Y_Offset_Caberation_600_600.eps (по умолчанию, рекомендован 

для тестирования) 

 
 Распечатать тестовое изображение. (Рекомендован принтер с высокой 

точностью печати) 

 Загрузить изображение в RX II и отправить файл на резку для тестирования 

 Если необходимо внести корректировки, отредактировать величину 

смещения, как описано ниже: 

■ Замерить величину смещения отпечатанной линии и линии реза. 

■ Ввести значение AAS Offset в разделе MISC с учетом полученных 

значений, затем нажать Enter 

■ Снова протестировать резку 

■ Величину смещения по осям X и Y для AAS II определяют следующим 
образом: 

Горизонтальная линия — X, вертикальная линия — Y  

(лицом к режущему плоттеру) 

■ Если нужно сместить линию реза и отпечатанную линию 

по направлению к исходной метке, указывают отрицательное значение 

смещения. Если нужно сместить линию от исходной метки, вводят 

положительное значение смещения (см. рис. ниже). Это относится 

к осям X и Y. 
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Примечание. 

 Перед изменением настроек AAS II выполняют масштабирование по ширине 
и длине. 

 Для тестового изображения смещение ножа не задано. Его настраивают в 

зависимости от выбранного ножа. 

 С вопросами обращаться к нам или к местному дистрибьютору. 
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5.4 Допустимое смещение приводочных меток 

Чтобы система распознала приводочные метки, необходимо следить за правильностью 

загрузки материала (по приводочной линейке на опорной пластине). При отклонениях, 

выходящих за приведенный диапазон, метки распознаны не будут. 

 
 

 
 

 

5.5 Контурная резка 

 
Для точности контурной резки с функцией AAS выполнить следующие шаги: 

 
 

Шаг 1 Создание графики 

■ Создать изображение, которое нужно отпечатать и вырезать через программу. 
 

 

■ Создать контур реза вокруг изображения. 
 

 

Совет 1. Оставлять место между изображением и контурной линией. 

Совет 2. Создавать контур в отдельном слое и присваивать ему другой цвет. 
 

■ Добавить приводочные метки вокруг изображения. 
 

Примечание. 

Можно воспользоваться функцией Multiple Copies. Она автоматически копирует 

изображение и метки приводки. 
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Шаг 2 Разместить приводочные метки 

 Макет в AAS: 
 

 
* Функция автораспознавания на 1й

 метке охватывает серую зону. 

 Рекомендованы поля в 30 мм слева и справа от листа материала. 

 Рекомендованы поля от верхней кромки листа от 20 до 30 мм, от нижней 

кромки — не менее 50 мм во избежание падения листа и на случай ошибки 

в размерах материала. 

Шаг 3 Отпечатать графику 

■ Отпечатать на принтере изображение и метки. 

(масштаб = 100 %).  

■ При печати на рулоне придерживаться следующей ориентации: 
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Шаг 4 Загрузить отпечаток в режущий плоттер 

■ Исходная метка должна отличаться от остальных приводочных меток. 

Необходимо проверить правильность направления подачи. 
 

  
 

 

Шаг 5 Вырезать контур 

■ Через программу дать команду выполнить задание на резку. 
 
 
 

5.6 Советы по AAS 

 
Чтобы результаты контурной резки были лучше, придерживаться следующих правил. 

 

 Работать с простыми источниками освещения, не освещать плоттер сбоку. 

 Перед запуском системы AAS изменить максимальный формат бумаги 

в свойствах драйвера RX II. 

Шаг 1 В папке Printer & Fax на компьютере найти модель RX II. 

Шаг 2 Открыть окно Properties (Свойства) и выбрать вкладку Paper (Бумага). 

Шаг 3 Изменить максимальный размер бумаги по оси X на 1200 мм. 

 Скорость резки установить в диапазоне 300–600 мм/с. 

 Проследить, чтобы прижимные ролики не закрывали приводочные метки. 

 При распознавании приводочных меток убедиться, что материал не загнут. 
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В этом разделе рассмотрено базовое техническое обслуживание режущего плоттера, 

включая очистку. Все процедуры, не вошедшие в перечень ниже, выполняются только 

квалифицированным сервисным специалистом. 

 
6.1 Очистка режущего плоттера 

Необходимо регулярно и тщательно очищать режущий плоттер — от этого зависит 

качество его работы. 

 

Меры 
предосторожности 
при очистке!  

 
 Во избежание удара электрическим 

током перед очисткой режущий плоттер 

отключить от розетки электросети. 

 
 Запрещается использовать для очистки 

растворители, абразивные чистящие 

средства и агрессивные моющие 

составы. Они могут повредить 

поверхность режущего плоттера 

и движущиеся части. 

 
 

 

Рекомендованные процедуры: 

 Осторожно протереть поверхность режущего плоттера безворсовой тканью. 

При необходимости смочить ткань водой или спиртом. Просушить и вытереть остатки 

влаги мягкой безворсовой тканью. 

 
 Протереть направляющие рейки каретки от пыли и грязи. 

 

 Удалить грязь и остатки материала из-под корпуса прижимного ролика с помощью 

пылесоса. 

 
 Очистить опорную пластину, датчики бумаги, прижимной ролик влажной тканью, 

смоченной в воде или в спирте и просушить мягкой безворсовой тканью. 

 
 Протереть стойку от пыли и грязи. 

Раздел 6. Техническое обслуживание 
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6.2 Очистка решетчатого барабана 
 

 
1. Режущий плоттер отключить, каретку отодвинуть от очищаемой области. 

 
2. Поднять прижимные ролики и отодвинуть от решетчатого барабана. 

 

3. Жесткой щеткой (можно зубной) очистить поверхность барабана от пыли. В процессе 

очистки проворачивать барабан вручную. См. рис. 6-1. 

 

 

 

 

 

Рис. 6-1 
 
 

 

6.3 Очистка прижимных роликов 

 
1. Если прижимные ролики нуждаются в очистке, удалять загрязнения с обрезиненной 

части роликов следует безворсовой тканью или тупфером. Чтобы прижимной ролик 

не проворачивались при очистке, придерживать ролик пальцем. 

 
2. Въевшиеся и стойкие загрязнения удалять безворсовой тканью или тупфером, 

смоченными в медицинском спирте. 

 
 

 

Примечание. Очень важно обслуживать режущий плоттер ежедневно. 

Для точности и качества резки решетчатый барабан и прижимные ролики 

нуждаются в регулярной очистке. 
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В этом разделе рассмотрены распространенные проблемы в процессе эксплуатации 

плоттера. Перед тем как знакомиться с содержимым раздела, убедитесь, что ваша 

программная среда совместима с режущим плоттером. 

 
 

 
 
 
 
 
 
 
 

Почему режущий плоттер не функционирует? 
 
 
 
 
 
 

Вероятные причины: 

 
7.1 Нарушения, не связанные с эксплуатацией 

 
Сначала проверить следующее: 

 Правильно ли подключен шнур питания к плоттеру? 

 Правильно ли подключен шнур питания к источнику питания? 

 Горит ли светодиодный индикатор питания? 
 

Решения: 

Если на дисплее отображаются сообщения, режущий плоттер исправен. Отключить 

и повторно включить режущий плоттер. Проверить, сохранилась ли проблема. 

Если на дисплее ничего не отображается, следует обратиться к техническим 

специалистам дилера. 

Примечание. 

Перед тем как обращаться за техническим 

обслуживанием, необходимо убедиться, что 

проблема в режущем плоттере, а не в 

интерфейсе, в компьютере или в программном 

обеспечении. 

Раздел 7. Поиск и устранение неисправностей 
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7.2 Нарушения, связанные с эксплуатацией 

 
К нарушениям работы могут привести механические неисправности и отказ функций. 

В сообщениях об ошибках, которые выводятся на дисплей, сначала указана проблема, 

затем рекомендованные действия. Если после выполнения рекомендованных действий 

проблема не исчезла, следует обратиться за техническим обслуживанием. 

 

В сообщении указывается, что проблема 

может быть по оси X. Проверьте, 

работает ли барабан и правильно ли 

загружен материал. Для перезагрузки 

системы устранить нарушение и включить 

плоттер повторно. 

 
 
 

 

В сообщении указывается, что каретке 

может что-то мешать на оси Y. Для 

перезагрузки системы устранить 

нарушение и включить плоттер повторно. 

 
 
 

 

В сообщении указывается, что 

неисправен датчик опускания и поднятия 

ножа. Для перезагрузки системы 

отключить и повторно включить плоттер. 

Если проблема не исчезла, следует 

обратиться к техническому специалисту. 

 
 
 

 

В сообщении указывается, что область 

реза превысила лимит. Загрузить 

материал большего размера или 

уменьшить изображение. Для 

продолжения нажать клавишу на дисплее. 

Error, Check Media 

Or Drum or X Motor 

Error, Check 

Media Or Y Motor 

Error, Check Carriage 

Sensor or VC Motor 

Graph Was Clipped. 

Data In Buffer 
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7.3 Нарушения взаимодействия режущего плоттера и компьютера 

 
Представленные ниже сообщения указывают на нарушения взаимодействия режущего 

плоттера и компьютера. 

 
 
 
 

 
 

Если режущий плоттер не распознает 

команды HP-GL/2 или HP-GL, 

проверить правильность применения 

команд HP-GL/2 или HP-GL к режущему 

плоттеру. 

Примечание. 

Настроенные параметры обмена данными для компьютера должны 

быть совместимы с требованиями плоттера. 

HP-GL/2 Cmd. Error 
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7.4 Отказ программных средств 

 
Сначала проверить следующее: 
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7.5 Снижение качества резки 
 

 

 
 
 

 
 
 

 

Примечание. Очень важно обслуживать режущий плоттер 

ежедневно. Для точности и качества резки решетчатый барабан 

и прижимные ролики нуждаются в регулярной очистке. 
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Технические характеристики серии RX II 

 

 
 

Номер модели: RX II-61 RX II-101S RX II-132S RX II-183S 

Способ работы Роликовый 

Ширина реза, до 610 мм 1010 мм 1320 мм 1830 мм 

Длина реза, до 50 м 

Ширина материала, от 810 мм 1326 мм 1635 мм 2145 мм 

Ширина материала, от 50 мм 

Кол-во прижимных 
роликов 

2 3 4 5 

Допустимая толщина 
материала 

0,8 мм 

Приводной двигатель Серводвигатель постоянного тока 

Усилие реза от 5 до 600 г 

Скорость реза, до 1530 мм/с (под углом 45°) 

Ускорение 4,2 G (ускорение свободного падения) 

Смещение от 0 до 1,0 мм (с шагом 0,025 мм) 

Буфер памяти 16 Мб 

Интерфейсы USB 2.0 (полноскоростной), последовательный (RS-232), Ethernet 

Тип команд HP-GL, HP-GL/2 

Физическое разрешение 0,006 мм 

Экранное разрешение 0,025 мм 

Точность перемещения ±0,254 или ±0,1% хода, по большей величине 

Повторяемость ±0,1 мм 

Автовыравнивание Полностью автоматическая система контурного реза для режима «печать–резка» 

Сглаживание дуг и 
кривых 

Да 

Настройка исходной 
точки 

Да 

Функция тестирования 
реза 

Да 

Тангенциальный режим Да 

Over Cut Да 

Повтор Да 

Копирование Да 

Перфорация Да 

Панель управления ЖК (20 символов х 2 строки), 15 клавиш, 1 светодиодный 
индикатор питания, 1 зеленый 51 

Диаметр ножа 2,5 мм 

Источник электропитания Переменное напряжение 100–240 В, 50/60 Гц (автопереключение) 

Энергопотребление 251,8 Вт 

Габариты (ВхШхГ), мм 437 х 1098 х 479 1147 х 1614 х 651 1147 х 1923 х 651 1147 х 2433 х 
756 Габариты (ВхШхГ) дюймы 17,2 х 43,2 х 18,8 45,2 х 63,5 х 23,8 45,2 х 75,7 х 23,8 45,2 х 95,8 х 
29,8 Масса нетто 25 кг 61,8 кг 71,5 кг 72 кг 

Автоматический отрез Стандарт 

Ширина отреза, не более 696 мм 1107 мм 1417 мм 1927 мм 

Стойка Дополнительно Стандарт 

Корзина для материала Дополнительно 

Условия 

эксплуат. 

Температура от 15 °С до 30 °С 

Влажность От 25 % до 75 % 



Серия RX II. Руководство 

Технические характеристики RX II A-1 

 

 

 

 Совместимость с ОС Windows 7 и выше, MAC OS X 10.6 и выше. (* При приобретении серийного 

номера ПО Sure Cuts A Lot, работающего с Mac OS.) 

 Спецификации и технические характеристики могут отличаться в зависимости от материала.  

Для оптимальных результатов рекомендуется проводить надлежащее систематическое 

техобслуживание устройства. 

 GCC оставляет за собой право на изменение технических характеристик без предварительного 

уведомления. 

 Данные приведены для материала Avery MPI 3000, сертифицированного GCC. 

 Приведенные выше технические характеристики действительны только при работе с материалами, 

сертифицированными GCC. 
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265019700G 

Для толстой флуоресцентной и витринной тонировочной пленки. Также 
для работ из стандартного винила с мелкими деталями. 

 Характеристики ножа: 45°, красная насадка, смещение 0,25 мм, 

диаметр лезвия 2,5 мм 

 

 

 

 
265017540G 

Для резки светоотражающего винила, картона, пескоструйных 
материалов, флока, острых краев трафарета. 

 Характеристики ножа: 60°, зеленая насадка, смещение 0,50 мм, 

диаметр лезвия 2,5 мм 

 

 

 

 
265017550G 

Для резки тонких пескоструйных масок и шаблонов на оборудовании 
с фрикционной подачей и лентопротяжной звездчаткой. 

 Характеристики ножа: 60°, синяя насадка, смещение 0,25 мм, диаметр 

2,5 мм, диаметр лезвия 2,5 мм 

 

 

 

 
265017560G 

Для резки мелкого текста и сложных деталей. Острый нож 
с минимальным смещением. 

 Характеристики ножа: 50°, черная насадка, смещение 0,175 мм, 

диаметр лезвия 2,5 мм 

 

 

 

 
265017530G 

 
Для тонких и хрупких материалов, включая витринные тонировочные 
пленки. 

 Характеристики ножа: 25°, желтая насадка, смещение 0,25 мм, 

диаметр лезвия 2,5 мм 

 

 

  

Технические характеристики ножей 
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Об инструменте 

 
Общий термин, обозначающий нож для резки листов, перо для графопостроения 

и светодиодный прицел (дополнительно) для наведения на точку привязки. 

СМЕЩЕНИЕ — расстояние, на которое сдвинуто лезвие ножа относительно 

центральной линии ножа. 

 
 
 

Нож 
 
 
 
 
 
 
 

 
 

 
 

Лезвие 

ножа 

Центральная линия 

 

смещение 

 

Выступающая высота ножа 
 
 

 

 
 
 

Выступающая 

высота ножа 

Толщина 

материала 

(t1) 

 

Толщина бумаги-

основы (t 2) 

 
 
 
 

Высота, на которую выступает нож = t1 + t 2/ 2. Для удобства можно считать, что это 

от 0,3 до 0,5 мм от края держателя. 
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Ниже описана процедура вывода файла из CorelDRAW. 

 

Инструкции для пользователя 
 

1. Открыть CorelDRAW, закончить редактирование всех файлов для вывода 

и выбрать сразу все изображения. 

 
2. Командой Outline Pen задать контур для резки. 

 

 
 

3. Установить значение ширины пера на 0,001 мм и подтвердить кнопкой ОK. 
 

 

Инструкция по выводу из CorelDRAW 
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4. Командой File > Print (Файл > Печать) отправить файл на режущий плоттер. 
 

 
 
 
 

5. Выбрать установленную модель. 
 

 
 
 
 
 
 
 
 
 

 



RX II. Руководство 

Вывод из CorelDRAW A-3 

 

 

 

6. На вкладке Layout для опции Reposition images to выбрать вариант: → Bottom left corner 

(Выравнивание по левому нижнему углу). 

Внимание: изображение должно находиться в нижнем левом углу. 
 

 
 

 
7. Вернуться на вкладку General и проверить, чтобы изображение было в нижнем 

левом углу. Нажать Print (Печать) и получить прекрасно вырезанное изделие. 
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Программа установки AASII VBA работает с CorelDRAW версий 13, 14, 15, 16, 17, 18 
 

Установка 

Установка программного модуля AAS дляCorelDRAW описана в шаге 8 раздела 2.7.1.2 

«Установка драйвера». 

 
Запуск программного модуля CorelDRAW AAS 

 

Шаг 1 Запустить CorelDRAW для редактирования графики и выделить сразу все 

изображения для отправки на плоттер. 

 

Шаг 2 Запустить макрос командой ToolsMacrosRun Macro. В меню Macros in выделить 

опцию Global Macros (GCCAASII_Draw13.gms) и нажать Run (Выполнить). 
 

 

Инструкция по модулю CorelDRAW 
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Шаг 3 Щелкнуть на кнопке Apply (Применить) и указать тип приводочных меток — 

по размеру страницы или по объекту 

  

Шаг 4 Теперь можно распечатывать файл с приводочными метками. 
 

 

 
 

 
Для модуля AAS можно добавить значок быстрого запуска 

 

Выполнить ToolsOptionsWorkspaceCustomizationCommandsMacros 

GCCMadual.GCC_AAS_Plug_In и нажать OK. 
 

  

Примечание. При щелчке на изображении по умолчанию выбирается опция 

Add Registration Mark by Object (Добавлять метки приводки по объекту).  

При щелчке на пустой области страницы по умолчанию выбирается опция 

Add Registration Mark by page size. 
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Добавление приводочных меток по странице 
 

Если установить флажок Add Registration Mark by page size и нажать Apply программа 

автоматически создаст приводочные метки (рис. A3-1). 

  

 
Рис. A3-1 

 

Рис. A3-2 

 

При перемещении изображения программа создает 4 метки на углах страницы,  

как показано ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. A3-3 

Примечание. 

1. Длина варьируется от 5 до 25 мм, 

в зависимости от размера страницы. 

 
2. При добавлении приводочных меток по 

странице, как показано ниже,  

НЕ ДОПУСКАЕТСЯ внесение изменений 

в раздел Origin во избежание смещения меток 

(см. рис. A3-2). 
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Рабочая область 

Позволяет редактировать и вырезать изображения за границами приводочных меток 

при условии добавления меток по странице. 

 
Для материалов A4 рабочая зона на 2,5 мм заходит за приводочные метки с правой 

и левой сторон, на 4,5 мм — за верхнюю метку. Рекомендованное расстояние до 

нижнего края материала — не менее 25 мм во избежание падения листа и на случай 

ошибки в размерах материала. 

 
Для материалов формата A3 рабочая зона на 10 мм заходит за приводочные метки 

с левой стороны, на 9 мм — с правой стороны, на 11 мм — за верхнюю метку. 

Рекомендованное расстояние до нижнего края материала — не менее 25 мм 

во избежание падения листа и на случай ошибки в размерах материала. 

 
 
 
 

 

 

Примечание. Для размотки рулона выбрать режим Edge при настройке 

формата материала. При работе в режиме Single лист материала нельзя 

переместить назад, а значит, фронтальный датчик бумаги его не распознает. 
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Добавление приводочных меток по объекту 
 

При установке флажка Add Registration Mark by Object на выбор доступно три 

варианта приводочных меток. 4-Point Positioning (по 4 точкам) 

 Length: длина меток 

 Диапазон: от 5 до 50 мм 

 Оптимально: 25 мм 

 Thickness: толщина линии меток 

 Диапазон: от 1 до 2 мм 

 Оптимально: 1 мм 

 Поля: Расстояние между метками и изображениями 

 Диапазон: от 0 до 50 мм 

 Оптимально: 5 мм 
 
 

Segmental Positioning (по сегментам) 

 X Step: расстояние промежуточного положения по оси X 

 Шаг Y: Расстояние промежуточного положения по оси X 

 Диапазон: от 200 до 600 мм 

 Оптимально: менее 500 мм 
 
 

 
 
 

 
Рис. A3-4 

Multiple Copies (создание копий) 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

 Диапазон: от 1 до 50 (чем больше копий,  

тем больше времени нужно на передачу данных). 

 Количество копий X * количество копий Y =  

общее количество копий изображения 

 Сopies with outline: для отображения контуров 

изображения 
 
 
 
 
 
 

 

Примечание. Значения, указанные в разделе 4-Point Positioning (длина, 

толщина, поля), действительны также с установленными флажками Segmental 

Positioning и Multiple Copies. 
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4- Позиционирование по точкам 
 

 

4-Point Positioning 

 Length: длина меток 

 Диапазон: от 5 до 50 мм 

 Оптимально: 25 мм 

 Thickness: толщина линии меток 

 Диапазон: от 1 до 2 мм 

 Оптимально: 1 мм 

 Поля: Расстояние между метками и изображениями 

 Диапазон: от 0 до 50 мм 

 Оптимально: 5 мм 
 
 
 
 
 
 
 

Рис. A3-5 
 

 

Программа создаст 4 метки, как показано на рисунке ниже. 
 

 
 

Рис. A3-6 
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Примечание. 

1. Для экономии материала при позиционировании по 4 точкам допускается менять 

не только поля объекта, но и длину приводочных меток (не менее 5 мм. 

Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 

меньшим должно быть расстояние между объектом и приводочной меткой (см. 

расчеты ниже). 

 
 
 
 
 

Область 
реза 

 
 
 

Рис. A3-7 Рис. A3-8 
 
 
 
 
 

 

Формат страницы 

(в мм) 

Рекомендуемая длина метки 

(в мм) 

A6 (105 × 148) 5 

А5 (148 × 210) 8 

А4 (210 × 297) 11 

А3 (297 × 420) 16 

А2 (420 × 594) 23 

А1 (594 × 841) и более 25* 

Таблица 1 

*25 мм — рекомендованная длина приводочной метки 
 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 

делать их слишком мелкими 

 
3. При изменении формата бумаги необходимо указать новые значения для 

приводочных меток, иначе применяются текущие настройки. 
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Позиционирование по сегментам
 

Для высокоточной резки рекомендуется выбрать режим 

Segmental Positioning, повысив точность обработки 

длинных и крупноформатных изображений. 

 
 
 
 
 

Позиционирование по сегментам 

 X Step: расстояние промежуточного положения по оси X 

 Шаг Y: Расстояние промежуточного положения по оси X 

 Диапазон: от 200 до 600 мм 

 Оптимально: менее 500 мм 
 
 
 

 

Рис. A3-9 
 

 

Программа создаст метки, как показано на рисунке ниже. 
 

 
 

Рис. A3-10 

 

При копировании объектов больших размеров (длина либо ширина более 200 мм) 

с функцией Multiple Copies к ним применяется позиционирование по сегментам — для 

более точного распознавания приводочных меток. 

По сегментам 
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Multiple Copies (Создание копий) 

Переключатель Multiple Copies повышает точность реза в случаях, когда из материала 

необходимо получить несколько экземпляров одного изображения. 

 
 
 
 
 
 
 
 

Создание копий 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

 Диапазон: от 1 до 50 (чем больше копий, тем больше 

времени нужно на передачу данных). 

 Количество копий X * количество копий Y = общее 

количество копий изображения 

 Сopies with outline：для отображения контуров изображения 
 

 

Рис. A3-11 

 

 

 

Программа создаст результат, как показано на рисунке ниже. 
 

 

Рис. A3-12 

ось Y 

ось X 
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Контурная резка через CorelDraw 

Шаг 1 Поместить в плоттер GCC бумагу с приводочными метками, отпечатанными 
на принтере. 

Шаг 2 Выполнить FilesPrint. 
 

 
 

 
Примечание.  
Для CorelDraw версии Х5 и выше выполнить описанные ниже шаги. 

Рис. A3-13 

 

Шаг 1 На вкладке «Color» в поле Color conversions performed by: (Выполнить 

преобразование цвета в:) указать модель плоттера (см. рис. А3-14). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. A3-14 
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Шаг 2На вкладке Layout для опции Reposition images to выбрать вариант Bottom left corner 
(Выравнивание по левому нижнему углу). 

   Рис. A3-15  

Шаг 3 Нажать кнопку Print. 



Серия RX II. Руководство 

Модуль Illustrator A-5 

 

 

 
 

 
 

Установщик AASII VBA работает с Adobe Illustrator версий CS4, CS5, CS6, CC. 
 

Установка 

Установка программного модуля AAS для Adobe Illustrator описана в шаге 8 раздела 2.7.1.2 

«Установка драйвера». 

 
Настройка принтера 

 

Шаг 1 Открыв окно принтеров через Панель управления, щелкнуть правой кнопкой 

мыши на принтере и выбрать Printer Properties, открыв диалоговое окно свойств 

принтера. 
 

 

Инструкция по модулю Illustrator 
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Шаг 2 Убедиться, что на вкладке Advanced (Дополнительно) снят флажок Enable 

advanced printing features (Включить дополнительные возможности печати). 
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Инструкции для пользователя 
 

Шаг 1 Открыть Illustrator. 
 

Шаг 2 Отредактировать изображение, создав контурную обводку. (Примечание. 

Ширину линии установить на 0,001 мм). 
 

 
 

 

Шаг 3 Щелкнув на изображении, применить функцию AAS(FileScripts_AASII_Plug_In). 
 

 

Линия 
контура 
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Шаг 6 Подтвердить приводочные метки (далее в примере рассмотрено 

позиционирование по 4 точкам). 

 

Шаг 4 Выделить нужные приводочные метки. 
 

 
 

Шаг 5 Здесь доступны три типа приводочных меток: 4-PointPositioning (по 4 точкам), 

Segmental Positioning (по сегментам), Multiple Copies (создание копий). 

 
 

 

Примечание. 

Значения, указанные для 4-Point Positioning (длина, толщина, поля), также 

действительны после установки флажков Segmental Positioning и Multiple Copies. 
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Шаг 6 Подтвердить приводочные метки (далее в примере рассмотрено 

позиционирование по 4 точкам). 

 
 

Шаг 7 Щелкнув на пустой области страницы, выбрать Document Setup (Настройка 
документа). 
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Шаг 8 Нажать кнопку Edit Artboards (Редактировать монтажные области). 
 

 

 

Шаг 9 Выполнить Presets → Fit Artboard to Artwork bounds (Подогнать монтажную область 

по выбранной иллюстрации).
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Шаг 10 После шага 9 навести мышь на панель инструментов слева и выбрать 

инструмент выделения Selection Tool. 
 

 
 

 
Шаг 11 Режим редактирования снова активен. 
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Шаг 12 Распечатать файл с линией контура и приводочными метками. 
 

 
 
 

Шаг 13 Поместив отпечаток в плоттер, ослабить прижимные ролики и подвести каретку к 

приводочным меткам. 

 

Шаг 14 Отправить файл на плоттер. 
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Шаг 15 Выбрав плоттер, поместить объект в левом нижнем углу. 
 

 
 

Шаг 16 Работа завершена. 
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Добавление приводочных меток по странице 

Чтобы создать метки приводки по размеру страницы, следует выделить объект, 

выполнить команду Scripts из меню File и выбрать AASII_Plug_In. 
 

 
 

 

Примечание. 

Длина метки составляет от 10 до 50 мм, в зависимости от размера страницы. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Установив флажок Make by page size, щелкнуть на 

кнопке Apply (Применить). В четырех углах 

страницы автоматически создаются метки 

приводки, как показано ниже. 
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Рабочая область 

Позволяет редактировать и вырезать изображения за границами приводочных меток 

при условии добавления меток по странице. 

 
Для материалов A4 рабочая зона на 2,5 мм заходит за приводочные метки с правой 

и левой сторон, на 4,5 мм — за верхнюю метку. Рекомендованное расстояние до 

нижнего края материала — не менее 25 мм во избежание падения листа и на случай 

ошибки в размерах материала. 

 
Для материалов формата A3 рабочая зона на 10 мм заходит за приводочные метки 

с левой стороны, на 9 мм — с правой стороны, на 11 мм — за верхнюю метку. 

Рекомендованное расстояние до нижнего края материала — не менее 25 мм 

во избежание падения листа и на случай ошибки в размерах материала. 

 

 

 

Примечание. Для размотки рулона выбрать режим Edge при настройке формата 

материала. При работе в режиме Single лист материала нельзя переместить 

назад, а значит, фронтальный датчик бумаги его не распознает. 
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Добавление приводочных меток по объекту 
 

При добавлении приводочных меток по объекту на выбор доступно три варианта. 
 

Выделив изображение, которое нужно обозначить метками, выполнить команду Scripts 

из меню File и выбрать AASII_Plug_In. 

 

Флажок Make by page size следует снять, а затем указать нужный тип приводочных 

меток. 
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Три типа приводочных меток 
 

Позиционирование по 4 точкам 
 
 
 

 

4-Point Positioning 

 Length: длина меток 

 Диапазон: от 5 до 50 мм 

Оптимально: 25 мм 

 Thickness: толщина линии меток 

 Диапазон: от 1 до 2 мм 

Оптимально: 1 мм 

 Поля: Расстояние между метками и 

изображениями 

Диапазон: от 0 до 50 мм 

Оптимально: 5 мм 
 
 
 
 
 
 
 
 
 
 
 

Программа создаст 4 метки, как показано на рисунке ниже. 
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Примечание. 

1. Для экономии материала при позиционировании по 4 точкам допускается менять 

не только поля объекта, но и длину приводочных меток (не менее 5 мм. 

Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 

меньшим должно быть расстояние между объектом и приводочной меткой (см. 

расчеты ниже). 

 

 

Область 
реза 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Формат страницы 

(в мм) 

Рекомендуемая длина метки 

(в мм) 

A6 (105 × 148) 5 

А5 (148 × 210) 8 

А4 (210 × 297) 11 

А3 (297 × 420) 16 

А2 (420 × 594) 23 

А1 (594 × 841) и более 25* 

Таблица 1 

*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 

делать их слишком мелкими 

 
3. При изменении формата бумаги необходимо указать новые значения для 

приводочных меток, иначе применяются текущие настройки. 
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Позиционирование по сегментам 

Для высокоточной резки рекомендуется выбрать режим Segmental Positioning, 

повысив точность обработки длинных и крупноформатных изображений. 

 
 
 

 

Позиционирование по сегментам 

 X Step: расстояние промежуточного положения по 

оси X 

 Шаг Y: Расстояние промежуточного положения по 

оси X 

Диапазон: от 200 до 600 мм 

Оптимально: менее 500 мм 
 
 
 
 
 
 
 
 
 
 

Программа создаст метки, как показано на рисунке ниже. По сегментам  
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Multiple Copies (Создание копий) 

Переключатель Multiple Copies повышает точность реза в случаях, когда из материала 

необходимо получить несколько экземпляров одного изображения. 

 
 
 
 
 
 
 

Создание копий 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

 Диапазон: от 1 до 50 (чем больше копий, тем 

больше времени нужно на передачу данных). 

 Количество копий X * количество копий Y = 

общее количество копий изображения 

 Сopies with outline：для отображения контуров 

изображения 

 Поля: Расстояние между метками; должно быть 0 

или ≧ 20; отрицательные значения не 

допускаются 

 

Программа создаст результат, как показано на рисунке ниже. 
 

 

Ось X 

ось Y 
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Руководство пользователя программного модуля GreatCut доступно на установочном 
DVD-диске GCC. 

 

Система GCC AASII 

Ниже приведена пошаговая инструкция по работе с функцией AAS в программе 

GreatCut через CorelDRAW и Adobe Illustrator. 

 
 

Редактирование изображений в CorelDRAW 
 
 
 
 
 

Позиционирование по 4 точкам 

Шаг 1 Создать новый файл в CorelDRAW. Нажать на значок Create contour (Создать 

контур) на панели GreatCut — появится автоматически после запуска CorelDRAW. 
 

 

Инструкция по подключаемому модулю GreatCut 
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Шаг 2 Настроить параметры контура, включая смещение контура, и подтвердить 

кнопкой Calculate (Расчет). 
 

  
 
 

К изображениям будут добавлены контурные линии. 
 

 

Смещение контура —  

расстояние между объектом 

и линией контура. 
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Совет: Закругленный контур для векторного объекта 
 

Функция Outline (Контур) повышает качество обработки векторных объектов. 

На острых углах заметна разница между вариантами Normal (Стандарт) и Round 

(Со скруглением). См. рис. ниже: 
 

  
 

Стандарт Со скруглением 

1. Кнопкой Create outline создать вокруг текстовых объектов контуры на свободно 

задаваемом расстоянии. 
 

  
 

 

2. Выбрать Round corners и указать параметры Offset и Tolerance. 

Offset — расстояние между внутренним и внешним контуром исходного 

объекта. В поле Tolerance указано, на каком расстоянии от угловой точки 

скругляется срез. 
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Шаг 3 Нажать значок Settings на панели инструментов GreatCut. 
 

 
 
 

Шаг 4 Нажать кнопку справа от поля Jog marks. 
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Шаг 5 В окне настройки указать размер, расстояние до объекта и толщину линий 

приводочных меток и подтвердить кнопкой ОК. 

Позиционирование по 4 точкам 

 Размер Длина меток 

 Диапазон: от 5 до 50 мм 

Оптимально: 25 мм 

 Поля объекта: Расстояние 

          между метками и изображениями 

      Диапазон: от 0 до 50 мм 

Оптимально: 5 мм 

 Line thickness: толщина линии 

меток 

 Диапазон: от 1 до 2 мм 

Оптимально: 1 мм 
 
 
 

Шаг 6 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 

 
 
 


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Шаг 7 Нажать значок Set Jog Marks на панели инструментов GreatCut. 
 

 
 

 

Программа создаст 4 метки, как показано на рисунке ниже. 
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Примечание. 

1. Для экономии материала при позиционировании по 4 точкам допускается менять не 

только поля объекта, но и длину приводочных меток (не менее 5 мм). Рекомендации 

для различных форматов см. в таблице 1. Чем меньше размер, тем меньшим должно 

быть расстояние между объектом и приводочной меткой (см. расчеты ниже). 

 

 
 

Формат страницы 

(в мм) 

Рекомендуемая длина метки 

(в мм) 

A6 (105 × 148) 5 

А5 (148 × 210) 8 

А4 (210 × 297) 11 

А3 (297 × 420) 16 

А2 (420 × 594) 23 

А1 (594 × 841) и более 25* 

Таблица 1 

*25 мм — рекомендованная длина приводочной метки 
 

2. Размер приводочных меток влияет на точность распознавания, поэтому 

не следует делать их слишком мелкими 
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Вывод 

Шаг 1 Выбрать объект целиком, включая приводочные метки и линию контура,  

и нажать значок Cut на панели инструментов GreatCut. 

 

Шаг 2 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 3 Из меню File выбрать команду Output (Вывод). 
 

 
 
 

Шаг 4 В окне выбора устройства Output to device в поле Mode/Tool указать Cut with AAS. 
 

 

Указать остальные параметры: 

AAS Offset, Pressure, Speed, 

Material width и пр. 



RX II. Руководство 

Модуль GreatCut A-6 

 

 

Шаг 5 Нажать Output — объект будет отправлен на режущий плоттер GCC. 
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Примечание. Разница между параметрами Number of outputs, Number of copies  

и Step count в окне Output. 
 

 
 

 

1. Значение параметра Number of outputs — 2: квадрат и треугольник 

вырезаются 1 раз, а затем обе фигуры вырезаются 1 раз в следующей 

позиции. 

 

2. Значение параметра Number of copies — 2: квадрат и треугольник вырезаются 

2 раза в той же позиции. 

 

3. Значение параметра Step count — 2: квадрат вырезается 2 раза в одной 

позиции, треугольник вырезается 2 раза в одной позиции. 
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Расширенная настройка 
 

Позиционирование по сегментам 

Для высокоточной резки рекомендуется выбрать режим Segmental Positioning, повысив 

точность обработки длинных и крупноформатных изображений. 

 

Для настройки линии реза и создания приводочных меток повторить шаги из раздела 

«Позиционирование по 4 точкам». В окне настройки указать размер, расстояние от меток 

до объекта, толщину линий приводочных меток, расстояние между метками и 

подтвердить кнопкой ОК. 

 

Шаг 1 Нажать значок Settings на панели инструментов GreatCut. 
 

 



Модуль GreatCut A-6 

RX II. Руководство 
 

 

 
 

Шаг 2 Нажать кнопку справа от поля Jog marks. 
 

 
 
 

Шаг 3 В окне настройки указать размер, расстояние до объекта и толщину линий 

приводочных меток и подтвердить кнопкой ОК. 

 
 
 
 
 

 

Позиционирование по сегментам 

 Max. x Distance: Расстояние 

промежуточного положения 

по оси X 

 Диапазон: от 200 до 500 мм 

 Max. y Distance: Расстояние 

промежуточного положения 

по оси X 

 Диапазон: от 200 до 500 мм 
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Шаг 4 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 
 
 

Шаг 5 Нажать значок Set Jog Marks на панели инструментов GreatCut. 
 

 

 
 
 


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Программа создаст метки, как показано на рисунке ниже. 
 
 

 

Позиционирование по сегментам 
 
 
 
 
 

 

ось Y 
 
 
 
 
 
 
 
 

ось X 
 
 

Для отправки файла на режущий плоттер GCC повторить шаги из раздела Вывод. 
 
 

 

Создание копий 
 

Шаг 1 Для настройки линии реза и создания приводочных меток повторить шаги 

из раздела Позиционирование по 4 точкам. 

 
 
 
 
 
 
 
 

При работе с функцией 

Multiple Copies применяются 

параметры, указанные 

в этом разделе. 
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Шаг 2 Нажать значок Set Jog Marks на панели инструментов GreatCut: будут созданы 

4 метки, как на рисунке ниже. 
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Шаг 3 Выбрать объект целиком, включая приводочные метки и линию контура, и нажать 

значок Cut на панели инструментов GreatCut. 

 
 
 

Шаг 4 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 5 Из меню File выбрать команду Output (Вывод). 
 

 
 
 

Шаг 6 В поле Mode выбрать Cut with AAS, указать количество изделий по осям X 

и Y, расстояние между копиями. Кнопку Output не нажимать. 

 

 
Шаг 7 Вернуться в CorelDRAW. Выполнить File > GreatCut > Multi-Copy. 
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Шаг 8 Указать параметры Number in X/Y (количество копий по осям X и Y), расстояние 

Distance in X/Y (расстояние между копиями). Нажать ОК. Убедиться, что значение 

Distance in X/Y совпадает с указанным в шаге 6. 
 

 
 
 

Примечание. Расстояние по горизонтали и вертикали (Offset X & Y) должно быть ≥ 20 мм 

или = 0 мм. Рекомендуется устанавливать параметр Distance in X/Y на 0 мм, чтобы 

не делать промежутков между копиями для экономии материала. 

 

Шаг 9 Программа создаст насколько копий объекта с приводочными метками, как 

показано на рисунке ниже. 
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Шаг 10 Отпечатать копии изображений, материал с отпечатками загрузить в режущий 

плоттер GCC. 
 

 

 
Шаг 11 В окне GreatCut нажать кнопку Output. 
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Редактирование изображений в Adobe Illustrator 
 
 

 

4- Позиционирование по точкам 
 

Шаг 1 Создать новый файл в Adobe Illustrator. 
 

 

 
Шаг 2 Выбрать изображение и выполнить File > GreatCut > Contour. 
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Смещение контура —  

расстояние между объектом 

и линией контура. 

 
 

Шаг 3 Настроить параметры контура, включая смещение контура, и подтвердить 

кнопкой Calculate (Расчет). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

К объекту добавлена линия контура. 
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Совет: Закругленный контур для векторного объекта 
 

Функция Outline (Контур) повышает качество обработки векторных объектов. 

На острых углах заметна разница между вариантами Normal (Стандарт) и Round 

(Со скруглением). См. рис. ниже: 
 

  
 

Стандарт Со скруглением 

1. Выполнить File > GreatCut > Outline, создав вокруг текстовых объектов 

контуры на свободно задаваемом расстоянии. 

  
 
 

2. Выбрать Round corners и указать параметры Offset и Tolerance. 

Offset — расстояние между внутренним и внешним контуром исходного 

объекта. В поле Tolerance указано, на каком расстоянии от угловой точки 

скругляется срез. 

 
 
 

 

Шаг 4 Выполнить File > GreatCut > Settings. 
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Шаг 5 Нажать кнопку справа от поля Jog marks. 
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Шаг 6 Указать размер, расстояние до объекта и толщину линий приводочных меток 

и подтвердить кнопкой ОК. 

 
 

4-Point Positioning 

 Size: длина меток 

 Диапазон: от 5 до 50 мм 

Оптимально: 25 мм 

 Object Margin: расстояние 

между метками и 

изображениями 

 Диапазон: от 0 до 50 мм 

Оптимально: 5 мм 

 Line thickness: толщина линии 

меток 

 Диапазон: от 1 до 2 мм 

Оптимально: 1 мм 
 
 
 
 
 
 
 
 

 

Шаг 7 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 



Модуль GreatCut A-6 

RX II. Руководство 
 

 

Шаг 8 Выполнить File > GreatCut > Set Jog Marks. 
 

 
 

 
Программа создаст 4 метки, как показано на рисунке ниже. 
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Вывод 

Шаг 1 Выбрать объект целиком, включая приводочные метки и линию контура, 

и выполнить File > GreatCut > Cut. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Шаг 2 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 

 



Модуль GreatCut A-6 

RX II. Руководство 
 

 

Шаг 3 Из меню File выбрать команду Output (Вывод). 
 

 

 
Шаг 4 В окне выбора устройства Output to device в поле Mode/Tool указать Cut with AAS. 
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Шаг 5 Нажать Output — объект будет отправлен на режущий плоттер GCC. 
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Примечание. Разница между параметрами Number of outputs, Number of copies 

и Step count в окне Output. 

 
 

 
 

 

1. Значение параметра Number of outputs — 2: квадрат и треугольник 

вырезаются 1 раз, а затем обе фигуры вырезаются 1 раз в следующей 

позиции. 

 

2. Значение параметра Number of copies — 2: квадрат и треугольник вырезаются 

2 раза в той же позиции. 

 

3. Значение параметра Step count — 2: квадрат вырезается 2 раза в одной 

позиции, треугольник вырезается 2 раза в одной позиции. 
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Расширенная настройка 
 

Позиционирование по сегментам 

Для высокоточной резки рекомендуется выбрать режим Segmental Positioning, повысив 

точность обработки длинных и крупноформатных изображений. 

 

Для настройки линии реза и создания приводочных меток повторить шаги из раздела 

Позиционирование по 4 точкам. В окне настройки указать размер, расстояние от меток 

до объекта, толщину линий приводочных меток, расстояние между метками 

и подтвердить кнопкой ОК. 

 

Шаг 1 Выполнить File > GreatCut > Settings. 
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Шаг 2 Нажать кнопку справа от поля Jog marks. 
 

 
 
 

Шаг 3 Указать размер, расстояние до объекта и толщину линий приводочных меток 

и подтвердить кнопкой ОК. 

 
 
 
 
 
 
 

Позиционирование 
по сегментам 

 Max. x Distance: Расстояние 

промежуточного положения 

по оси X 

Диапазон: от 200 до 500 мм 

 Max. y Distance: Расстояние 

промежуточного положения 

по оси X 

Диапазон: от 200 до 500 мм 



Модуль GreatCut A-6 

RX II. Руководство 
 

 

Шаг 4 Выполнить File > GreatCut > Set Jog Marks. Будут созданы 4 метки,  

как на рисунке ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Ось Y 
 
 
 
 
 
 
 
 
 

 

Ось X 

По сегментам 
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Создание копий 
 

Шаг 1 Для настройки линии реза и создания приводочных меток повторить шаги из 

раздела «Позиционирование по 4 точкам». 

 
 
 
 
 
 
 
 

При работе с функцией Multiple 

Copies применяются параметры, 

указанные в этом разделе. 

 
 
 
 
 
 

 

Шаг 2 Выполнить File > GreatCut > Set Jog Marks. Будут созданы 4 метки,  

как на рисунке ниже. 
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Шаг 3 Выбрать объект целиком, включая приводочные метки и линию контура, 

и выполнить File > GreatCut > Cut. 
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Шаг 4 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 5 Из меню File выбрать команду Output (Вывод). 
 

 
 
 

Шаг 6 В поле Mode выбрать Cut with AAS, указать количество изделий по осям 

X и Y, расстояние между копиями. Кнопку Output не нажимать. 
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Шаг 7 Вернуться в Adobe Illustrator. Выполнить File > GreatCut > Multi-Copy. 
 

 
 
 

Шаг 8 Указать параметры Number in X/Y (количество копий по осям X и Y), расстояние 

Distance in X/Y (расстояние между копиями). Нажать ОК. Убедиться, что значение 

Distance in X/Y совпадает с указанным в шаге 6. 
 

 
 
 

Примечание. Расстояние по горизонтали и вертикали (Offset X & Y) должно быть ≥ 20 мм 

или = 0 мм. Рекомендуется устанавливать параметр Distance in X/Y на 0 мм, чтобы 

не делать промежутков между копиями для экономии материала. 
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Шаг 9 Программа создаст насколько копий объекта с приводочными метками,  

как показано на рисунке ниже. 
 

 
 
 

Шаг 10 Отпечатать копии изображений, материал с отпечатками загрузить в режущий 

плоттер GCC. 



Модуль GreatCut A-6 

RX II. Руководство 
 

 

 

 

Шаг 11 В окне GreatCut нажать кнопку Output. 
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Инструкция по SignPal 12 A-7 

 

 

 

 
 

Программа SignPal 12 совместима с ОС Windows. Все версии поддерживают 

функцию контурной резки AAS II. 

 

Инструкция по SignPal 12: содержание 

[1] Установка программного обеспечения SignPal 12 

[2] Настройка плоттера GCC через Production Manager 

[3] Начало работы с SignPal AASII 

[4] Перечень функций SignPal 12 

 

[1] Установка программного обеспечения SignPal 12 

Для установки программы необходимы права Администратора (Administrator).  

Для работы с программой необходимы права Опытного пользователя (Power User). 

Подробнее в руководстве пользователя Windows. 

 

1. Удалить предыдущие версии программы, если они есть. 

 

2. Открыть сайт GCC Club (http://gccf.gcc.com.tw/gccclub/login.aspx), войти в систему 

и выполнить Drivers > Cutter > Others > SignPal 12, чтобы загрузить файл WinRAR. 

 
 

3. Установить и активировать SignPal 12, выполнив перечисленные ниже шаги. 

Инструкция по SignPal 12 

http://gccf.gcc.com.tw/gccclub/login.aspx
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(1) Установка и активация ПО на компьютере с интернет-
подключением 

 

1. В адресной строке браузера ввести https://www.saicloud.com , нажать Enter. 

Ввести код активации и нажать Activate. Код активации находится на 

этикетке программного обеспечения. 

 
 

 
 

2. При входе в систему выбрать I am new to the SAi Cloud и указать адрес 

электронной почты. Нажать Create Account. На указанный адрес будет 

отправлено сообщение. 

 
 

 

https://www.saicloud.com/
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3. Найти сообщение в почтовом ящике и щелкнуть по ссылке 

в письме. Заполнить поля для информации. 
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4. С помощью WinRAR запустить из архива файл Autorun. Установить 

программу, следуя подсказкам мастера установки. 
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5. Вставить код в поле для кода активации. 
 

  
 

6. Выбрать нужный язык, нажать OK и завершить установку. 
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(2) Установка и активация ПО на компьютере без интернет-
подключения 

 
1. С помощью WinRAR запустить из архива файл Autorun. Установить 

программу, следуя подсказкам мастера установки. 
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2. Записать идентификационный код компьютера из диалогового окна ниже. 

Найти имя вашего компьютера. Для этого правой кнопкой мыши щелкнуть на 

значке Мой компьютер и выбрать Свойства. 

 

  
 

3. На компьютере с интернет-подключением запустить браузер и набрать 

в адресной строке браузера https://www.saicloud.com. Подтвердить 

клавишей Enter. Ввести код активации и нажать Activate. 

Код активации находится в сертификате программного обеспечения. 

 

 

 

https://www.saicloud.com/
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4. При входе в систему выбрать I am new to the SAi Cloud и указать адрес 

электронной почты. Нажать Create Account. На указанный адрес будет 

отправлено сообщение. 

 

 
 
 

5. Найти сообщение в почтовом ящике и щелкнуть по ссылке 

в письме. Заполнить поля для информации. 
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6. Нажать License Manager can’t connect? (Диспетчер лицензий не может 

подключиться?). Указать код компьютера и имя компьютера, которое 

вы записали ранее. Нажать Create License Now (Создать лицензию) 

и Download License Загрузить лицензию), сохранить файл на компьютер. 
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7. Скопировать файл лицензии на компьютер без интернет-подключения с диска, 

импортировать его. 

 

 

 

 

 
8. Выбрать нужный язык, нажать OK и завершить установку. 
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(3)Перенос лицензии на компьютере с интернет-подключением 
 

1. Открыть License Manager из меню Start. 
 

 

 
2. Выбрать Remove License From This Computer (Удалить лицензию 

с этого компьютера). Теперь программное обеспечение можно 

установить на другой компьютер. 
 

 



Инструкция по SignPal 12 A-6 

RX II. Руководство 
 

 

 

(4) Перенос лицензии на компьютере без интернет-подключения 

 

1. Открыть License Manager из меню Start. 
 

 

 
2. Выбрать Remove License From This Computer. Ввести код деактивации 

в диалогом окне License. 

 
 

3. На компьютере с интернет-подключением запустить браузер, 

зайти на https://www.saicloud.com и войти в свою учетную запись. Выбрать 

License Removed (Лицензия удалена), ввести код деактивации и нажать 

Remove. Теперь программу можно установить на другой компьютер. 

https://www.saicloud.com/
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[2] Настройка плоттера GCC через Production Manager 
 

1. Открыть Production Manager 12 

2. Выбрать и настроить режущий плоттер GCC 

(Система AAS II работает только с моделями RX II, Jaguar V LX, Puma III, 

Expert II LX.) 
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3. В программе SignPal выполнить File > Print Setup и выбрать принтер. 
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4. В программе SignPal выполнить File > Document Setup и указать формат бумаги. 
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[3] Начало работы с SignPal AASII 
 

1. С помощью инструмента Rectangle создать прямоугольник. 
 

 
 

2. Выполнить Effect > Contour Cut. В окне DesignCentral нажать Apply (Применить). 
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3. Применить метку контурной резки GCC AASII, выполнив Effect > Contour Cut 
Mark. 

 

 
 

 
4. В окне SignPal DesignCentral выбрать GCC AASII, чтобы создать приводочные 

метки AAS II (позиционирование по 4 точкам). Подтвердить кнопкой Apply. 
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5. Есть три варианта приводочных меток GCC AAS II: 4-Point Positioning  

(по 4 точкам), Segmental Positioning (по сегментам), Multiple Copies (создание 

копий). Для позиционирования по сегментам в окне DesignCentral выбрать GCC 

Segmentation и нажать Apply. 
 

 
 

6. Создание копий в SignPal недоступно. На текущий момент воспользоваться 

функцией копирования можно только через модуль для CorelDraw. 

 
7. Для вывода изображения выполнить File > Print. 
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8. В окне Print (Печать) установить значение Scale (Масштаб) равным 100 %. 
 

 
 
 

9. Загрузить в плоттер винил и отправить данные командой File > Cut Contour.  

На вкладке Properties (Свойства) диалогового окна Cut Contour доступен 

предварительный просмотр задания. Здесь же можно изменить параметры 

резки. Система Production Manager автоматически активируется для 

выполнения задачи. 
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[4] Перечень функций SignPal 12 

 
 Эксперт Новичок 

Текст 

Работа с текстом ● ● 

Текст по дуге ●  

Текст по кривой ●  

Вертикальный текст ● ● 

По вертикальной кривой ●  

Кернинг ●  

Разделить/Объединить ● ● 

Рисование 

Безье ● ● 

Свободное рисование ● ● 

 
Фигуры 

Прямоугольник ● ● 

Овал ● ● 

Приводочные метки ● ● 

Размеры ● ● 

Редактировать кривую 

Выбрать точку ● ● 

Удалить точку ●  

Добавить точку ●  

Выпрямить кривую ●  

Скруглить угол ●  

Заострить угол ●  

Оптимизировать по кривой ●  

Оптимизировать по дуге  
 

● 

 

Оптимиз. по 3 точкам дуги ●  

Создать дугу ●  

Сократить число точек ●  

Замкнуть кривую ●  

Изменить начальную точку ●  

Разделить ●  
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Ножницы ●  

Создать прямой угол ●  

Разорвать кривую ●  

Соединить кривые ●  

Выровнять по горизонтали ●  

Выровнять по вертикали ●  

Выровнять точки ●  

Применить длину и угол  
 

● 

 

Удалить мелкие объекты ●  

Векторный ластик ●  

Разделить по кривой ●  

 
Работа с файлами 

Информация по заданию ●  

Сканирование ●  

Выйти в облако ● ● 

Рабочие области ● ● 

Вид 

DesignCentral ● ● 

Цветовой микшер ● ● 

Захват ● ● 

 
Упорядочивание 

Сгруппировать ● ● 

Объединить ● ● 

Маскировать ● ● 

Направляющие ● ● 

Контурная резка ● ● 

Перевести в кривые ● ● 

Преобразовать 

элементы в кривые 

 
 

● 

 
 

● 

Преобразовать связанные 

во встроенные 

 
 

● 

 
 

● 

Направление кривой ● ● 

Упорядочить ● ● 

Порядок резки ● ● 
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Выровнять 

 

● 

 

● 

Расстояние ● ● 

Повернуть ● ● 

Изменить размер ● ● 

Убрать перекос ● ● 

Зеркально отобразить ● ● 

Многократно копировать ●  

Эффекты 

Комбинирование ●  

Контур ●  

Контурная резка ● ● 

Метка контурной резки ● ● 

Тень ●  

 
Растр 

Автотрассировка ●  

Цветовой режим ●  

Производство 

Резать/рисовать ● ● 

Ручное разделение 
линий 

● ● 

Упорядочить все копии ● ● 

Монтировать до границы ● ● 

Автоматическое слияние ● ● 

Автоматический 
треппинг 

● ● 

Нахлест ● ● 

Оптимизация порядка 
резки 

● ● 
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Ниже приведены базовые сведения по работе с программой Sure Cut A Lot.  

За более подробной информацией обращаться к справочным файлам Sure Cut A Lot. 

 
1. Выбрать нужный принтер и изменить рабочую область. 

 

Шаг 1 Запустить программу Sure Cuts A Lot. 
 

  
 

 
Шаг 2 Для изменения рабочей области в меню Cutter выбрать My Cutter, 

затем Manage Cutters. 
 

 

Программа Sure Cuts A Lot 
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Шаг 3 В списке компаний и марок выбрать GCC и нужную модель, нажать кнопку  

Add to list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Шаг 4 Слева выбрать GCC и нажать Done. 
 

 

Шаг 5 Чтобы изменить размер и ориентацию рабочей области, нужно ввести 

соответствующие значения в окне Document (Документ). 
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2. Вставка изображения из библиотеки 
 

Шаг 1 Для вставки выбрать в библиотеке нужный файл с изображением. 
 

 
 
 

 

3. Добавление текста 
 

Нажав значок T слева, в текстовом окне ввести текст и выбрать нужный шрифт. 
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Сов
еты 

 

4. Импортирование макета 
 

Макет из другой графической программы импортируют командой Import или Place 

image из меню File. SCA поддерживает форматы svg, scut, scal, pdf, ai. eps, png и wpc. 
 

 

 

 

Специально для ПО Sure Cuts A Lot созданы тысячи файлов SVG! 

http://SVGCuts.com — лучший ресурс для создания дизайнов в формате 

SVG. Тысячи элементов в высоком качестве: шаблоны для открыток, 

скрапбукинга, подарочных пакетов, коробок, объемных цветов. 

http://svgcuts.com/
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5. Преобразование изображения в файл реза 
 

Шаг 1 Открыть окно настройки, выполнив Trace Image (Трассировка изображения) 

из меню File или щелкнув на кнопке Trace Image на панели инструментов. 
 

 
 
 

Шаг 2 Импортировать изображение кнопкой Choose an image, указать настройки 

изображения (Image Settings) и вывода (Output Settings) и нажать OK.  

Программа автоматически создаст контур изображения. 

 
 

 

Примечание 

 На результаты трассировки влияют контрастность и пиксели. 

Предпочтительно импортировать файлы с высокой контрастностью. 



Программа Sure Cuts A Lot A-8 

RX II. Руководство 
 

 

 

6. Резка макета 
 

Шаг 1 Кнопкой Cutter на панели инструментов открыть диалоговое окно настроек. 
 

 
 

Шаг 2 Щелчком на кнопке Settings… открыть диалоговое окно GCC Cutter Settings. 
 

 
 

 

 

Шаг 3 В окне GCC Cutter Settings при необходимости отрегулировать приводочные метки. 
 

 
 

 

* Registration Marks (Приводочные метки): настроить расстояние между 

кромкой материала и приводочными метками в поле Mark Offset; размер 

меток — в поле Mark Size; толщину линий — в поле Mark Thickness. 

Примечание 

 Исходная точка находится справа внизу. 
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Шаг 4  При необходимости задать настройки Blade Offset , Overcut Value, Multi-Cut 

и Quality в окне CutSettings. 
 

 
 
 

 

*Blade Offset (Смещение ножа): задается с учетом типа ножа; для 

стандартного ножа составляет 0,25 мм, для дополнительного 

улучшенного ножа — 0,5 мм, для дополнительного пера — 0 мм. 

 
*Quality (Качество): чем выше качество, тем ниже скорость 

обработки. 

 
*Multi-Cut (Несколько проходов): для повторного выполнения 

задания из той же позиции при резке толстого материала. 

 
*Overcut (Нахлест): упрощает отделение облоя и компенсирует 

незамкнутые линии реза. 
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Шаг 5 В разделе Cut Settings предусмотрен ряд полезных функций. Задав нужные 

параметры, данные отправляют на режущий плоттер GCC кнопкой Cut. 

Плоттер начинает работу. 
 

 
 
 
 

 

*Cut Mode (Режим резки): параметры WYSIWYG и Origin Point. 

Режим WYSIWYG — плоттер выводит изображение точно так же, 

как в окне предварительного просмотра. В режиме Origin Point 

(Исходная точка) плоттер начинает резку с левой верхней точки 

материала. 

 
*Use Software Speed and Pressure (Программные скорость 

и давление): установите флажок, чтобы вручную задать 

параметры скорости и давления. 

 
*Preset (Предварительные настройки): программа автоматически 

задает скорость и давление реза для выбранного материала. 

 
*Speed & Pressure (Скорость и давление): для повышения 

качества можно настраивать вручную скорость и давление реза. 
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7. Печать и резка макета 
 

Функция Print and Cut позволяет отпечатать изображение из программы Sure Cuts 

A Lot на принтере, а затем загрузить материал с распечаткой в режущий плоттер GCC 

и через Sure Cuts A Lot вырезать по контуру. 

 

Шаг 1 Открыть файл с изображением в программе Sure Cuts A Lot. 
 

 

 
Шаг 2 Щелкнуть на значке плоттера (Cutter) на панели инструментов, задать нужные 

параметры. Щелчком на опции Print+Cut добавить приводочные метки 

и распечатать изображение. 
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Шаг 3 Щелчком на опции Print… открыть окно настроек принтера и нажать OK. 
 

 
 
 

Шаг 4 Распечатать макет с наружными приводочными метками. 
 

 
 

 

Шаг 5 Загрузить запечатанный материал в режущий плоттер GCC. 
 

Шаг 6 Нажать Next, затем Scan+Cut. Плоттер GCC распознает приводочные метки 

и автоматически вырежет контурные линии. 
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Совет  Как экономить материалы с функцией Test Connection. 

 Нажать кнопку Test Connection, чтобы проверить соединение. 


